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CHAPTER 1

AutoCAD"® \\ =

START
AutoCAD 2005

5.0 The User Interface

u Start-AutoCAD 2005 o3 dlick cxbdlechi sledqé AutoCAD splash screen mbe sol
onffk [geopodagaist & (o o) erlgeoniodeacit: AutoCAD 2005- [Drawingl.dwg] soepss
drawing window el exnegdh drawing area § sedl swndo) Menu bar cmes meny
6003 choose cvdedquloncdi default menu 3o acad.mnu cli menu wdac3 mad(g
36q€ menu name o} click p6§clou sleewncd ALT key §6aox(G: underlined letter

o::o%sco% click ng)elémé:slcﬂmogu Menu bar emcﬁep toolbar cop sagp:@:gp']oxﬁn
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Toolbar 3¢ AutoCAD command oy} start coeory button sogdl§e’ bar eodadl
toolbar edle> mouse cursor cdaonsoiciongé 938 command button §seepSadeslfg
oy tooltip edaedlanoleci AUtoCAD mess odiatiedleuo) toolbar sy Standard
toolbar Styles toolbar | Layers toolbar | Properties toolbar | Draw toolbar $ Modify
toolbar o3ulon toolbar 098:30% floating @5@5 1 docked 5@5@5 @loga)c{f)coozc%qcﬂonugu

Menu bar —— Floating toolbar

— Docked toolbar Flyout toolbar
Drawing area

ia

Fle Edit “ew Insert Formst Tools Draw| Dimension Moy Window Help - g X
|| B Stndad| ! dlStndmd | @ Standae ]
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floating toolbar c&s0x drawing area wen §3¢3 §es8Eclonddn ¢ (0. o) ¢l
Standard toolbar o3 Menu bar esaachones drag scocdGieox; floating toolbar [gdesné
drawing area o> egljoontomdch mdmabeor; floating toolbar ox6ac drag 1 resize
dock s@og%c?acxogqorlooogu docked @533’3:618 drawing area § 92§5:06 dMHE> M6
¢>0lon docked toolbar o3 drag s3waff: move cobcdgoaudecon toolbar cd94, proh
co006[E5%9? @6%9@:9&)2@8?&&1& flyout toolbar o:mci? OOSGOTC\)D%E:O']GJQSH & fiyout
ames current command %aoo%ogtﬁgg]c@ c;@cﬁoof)mg%,eogo‘og GUTGU‘:[%_,:(?’)O?II poe> Zoom
window icon edle cursor oG left mouse button 3eaonqg & (0. o) enfgeonaisacic:
flyout toolbar edTandle

To display a toolbar

3 (0. 0) woweay qoy toolbar codaecd display eoecl g€ View-3Toolbars o3 click o

tooibar sraogc% check box o% check c\36@: Close button rrii click ogéslo'iecﬁn 3 (o. J

Customize dialog box ecl'axcysesl Toolbars tab o3850l Greomet 88 display axbgiéa)

Blogescln qpudodegradondepdio & (0. o) o toolbar button o;éad right-click codE:
shortcut menu GOTC\J’JSlE 9’38036:‘?@[08@ toolbar macnzso% choose C\Ecc)c{fgqor]oau%u

Toglhars Menu Group
[]CAD Standards CusTOM H———
[ Dimension Rename...
L]0ine (Renane.. ] |
] Draw Ordet
[Minsert 1 .
E::Z:ts [ Large buttons (I'-) (O° J)
Modify Show ToalTips on toolbars ¢ -
Egaﬂg gnap o Show shorteut keys in ToalTips ‘
Propeities ]
[ Retedit ¢ ]
[JRelerence r
[1Render bt}

Close __ Help

toTo) Start AutoCAD 2005
]



» To use the Command window

Y

o (0. o) oo drawing area § esmodmodendod window pane vozdeé AutoCAD $360)
L 170 L e
system variables | options | messages | prompt coye? display «pog&éay dockable/
resizable window e>$36151 Command window c3sal Slescn User saadgaéoy 288,

o3 keyboard mes§odcopfl: ENTER key oSeondS Spacebar 386[8: :28§c0:dq
dlooci 0263, command lep 2006006003 control 6oy system variable eoyoBaogh:
command window g>0§cbeopdeeadh ordg), command ecge> command alias ecp§eé
pown CIRCLE command 3(?3616 G o%%o%ooéém%qo']mosu command alias 8080% acad.psp
OC ~ oy Loy e N < c c o (] a

Qcmgooge:omzo"loamu AutoCAD 3osdesmsien mafgn: command mosad oypyboeal
[gaéeé prompt edlamaiegachen apostrophe (') G)d%?()%%&l&@ﬁl:@:? command o3

(o)

sepaplecdi & (0. p) Blgpdes LINE command Bsead(qesorsier Specify first point:

L

g prompt eolcnomad mgecfggéicond GRID command o} [m3xifgodead§eniadad

L

ox0loI

[/ 41> | ¥ K Lovout { Layoutz /

Regenerating nodel .

wd |AutoCAD menu utilities loaded.

Z Command: LINE

“ Specify first point: 'GRID

% »»Speciiv grid spacing(X) or [OHAOFF/Snap/Aspect] <0, 50005 1
=

]

Fesuming LINE command.

Specify first point: o h el
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To display the text window

% (2. 9) oo command line eneepdcd command eapa3 hard copy cBgcqd F2 key 386
qoleddi o (0. g) %)o@ooo:o}sao%if:: text window edlangé Edit-Copy 8’3616026@:
WordPad o3en Edit->Paste cyéqé hard copy o3 print coo5opeol

Edit

t

REegenerating nmodel .

AutoCAD menu utilities loaded.

Command : LINE

Specify first point: 'GRID

>»Specify grid spacing(X) or [ON-QFF/SnapsAspect] <0.5000»: 1

Hesuming LINE command.

Specify first point: e RS I

& (0 9)

>, Start a New Drawing

c &9 C <

new drawing co@:iaor% start cooewsdge drawing sacgmgaa?:@eo,_% units § setting sop
a Setup Wizard ( ) Start
a drawing from Scratch $ (o) Use a template file s80j5p5:eapigocloncdi agdenoy

-

< C

o%axﬁ?ogeo:quﬂu start cpogpo: (3) ;é:?qo’]cmﬁu (o) Use
Setup Wizard $o5:030 seqedmipoqesaty

To begin a new drawing using a Wizard

FileNew o3 click codclecdn Create New Drawing dialog box géeaxnqé Command

o Start AutoCAD 2005
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window o> command line ¢> STARTUP o3§c5copsfi: system variable o3 0 a0z 1
conteusqulecdn sladeé FileNew a3 click [g§cobqE Create a New Drawing dialog box
GOTC\)O(;]@II o (o. 3) a%@écﬂu Use a Wizard button o% click C\E&ﬂecf)u

- Detault Settingg ——- - -+ -Use a Wizard

(&) Imperial [feet and inches)

(O Metiic

r‘Tip
‘ |Jzes the default imperial [feet and inches) settings. l :

{

| 4 863l O (0. 6) edlamet Select a Wizard box cdez§o) Advanced Setup o3 choose
QO |§ oK n? click ngor]gu)u

> slsBq¢ Advanced Setup §ocoesd: Wizard eclcondl§r & (0. 9) Blogpach Spgoum
Units format co63sacpabaldn eax&sff 1 Select the unit of measurement csxdbon
Architectural option o3 choose axéoleddn Architectural (feet/inches) format § data
oogeoososlc Bom 70 feet 5 inches m 70'5 co eq.chorlmwu 70' 5" 3 Q) eeg o)epeco
o']:n o Next > o Cllck mocﬂeoou
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Quick S E!T\:JD

@ [ 0

Select a Wizard:

~Wizard Description 7
. . L
Sets the unitz, angle, angle measure, angle direction, and area for your new l

drawing. Based on the template acad.dwt.

0% '1}6‘“ Cancel |

B Units
Angle
Angle Measuie
Angle Direction

Area

Selact the Lt

O Decimal
{2 Engineering !%“_17 “
(&) Achitectural ::: ::!! 1-31/2
{ Fractional "LEJ
(O Sciertific.

Precision:

of measuiement.

|a-01/18" [v]

. Bacl I Nexuq [ _Cancel“_J

¢ (0:9)

)
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> 8cnbsl Advanced Setup Wizard o> Angle type s0305 egraSenfgboloocdn Decimal

o]

Degrees option o3 enable cx0[G: Precision: listbox mes 0,00 o8 choose cxdolecSn B

L

comgt Next > o3 click cobdli & (0. 0) Blogpdcl

. Select the angle of measuremant and the precision for
Units angles.
» Angle (&) Decimal Degrees
Angle Measure ) Dag/Min/s
g/Min/Sec *“—\\
Angle Direction O Grads \EIEI i
Area ) Radians ]
O Survepor :
Precisian:
[ ™
[. < Back ][_ Ne;-ct>,}’] rﬁancel
g
O (o. m)
| 2 mambsledcnagy Wizard aoxeoxn Angle Measure format sa0305 sgegedgdli & (o. @)

m@@(ﬂu default starting angle o3 > 0 degree - East maooaeoaooo s0loncSi GOOOE@ |
Next > o? click cxeoc.ﬂeoou

> 8503 Angle Direction o5 Counter-Clockwise § Area o3 80' x 60" conclochi &
(o 20 0%@@07|| c;@m@ FlnISh button o> Cllck c\)oo']eoou
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Select the direction for angle measurenient

Units
Angle @ East . N
p Angle Measure ) North p
&ngle Direction ) wiest W E
18000 i)
Area {0 South
270.00
) Gther 3
[ < Back ][ MHewt » '\Q'] [ Cancel J
b
¢ (e
e e ——
Advanced Setup ' .
Enter the area you wani to represent using full scale
Units units. Example: 1o drawe in an area 12 x 9 meters, enter
12 under “width and 3 under Length,
Angle
Angle Measure Widih:
Angle Direction 80
B Area Length
E
9606000
{ < Back ][ Firgh ‘kj [ Cancel
(e (Oe OO)
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> drawing setup cx8Eaynqé File>Save As coddlecdi & (0. 09) eafgeoncimait: Save
Drawing As dialog box edlaxeé AutoCAD 2005 folder esx03¢00 MyDrawings soepbs
New Folder cdac? create coé(G: File name: box ¢ NewDrawing s3§cbcogholecd
egacb(Ge Save button o3 click cobeé MyDrawings folder cd¢o NewDrawing.dwg &¢

cy oC ¢ ¢ C
§’)QE% LLDCS?Q)‘DO)OEE(D') save B@Og):(;]@ll

Save in: |@MyDrawLngs @ én 'Qa @ x \:g_ "}{;ews v Tookk -

Praview - s ~

Name = { Size‘} L

History

|

s

ﬁ My Documents

X

Favorites

-
i
‘Uﬁ

3
Deskl
s [ Update sheet and view thumbnails now
" S SO T o
Buzzss | £y cupe | AutoCAD 2004 Drawng [ dwo) [v][ _ Concel |
(.e (O. OO)

» To start a drawing by selecting a template file

File>New o click co6f: Create New Drawing dialog box géangé Use a Template
button o3 click coSclecsi Breomst Select a template: camcden template o633
choose cw&feor OK o3 click c8qtqelenddi (0. 0 ) Blegpsch
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mﬁ-’ D I é Use a Template

Select a Template:
Ansi d -color dependent plat styles. dwt '

Anzi d -named plot styles. dwt

Ansi e -color dependent plot styles. dwit
Anzi e -named plot styles. dwt

“hrE E\awjut PemplnfE>dl“I

Architectural 24" x 35" lite block and border. Uses Color Dependent Plat Styles.

Jj

Lok :\‘,] [ Cancel |
4

: [ Template Descrption

¢ (e-0))

o.o Customize AutoCAD Colors

drawing area o default sa654 20pSiepbamdlendbi drawing area § seeepéadegat:
5€q€ 22903e[gre:cdeclonddi Tools—Options &3 click cxé[G: Options dialog box dl

QoC

onoyoest Display tab 0386: Colors button o3 click cobcl & (0. 0p) Bfogpsdl

8 (0. 06) eolgaomoizdit: Colors Options dialog box eolaxclssslnqé Model space
(r?_) click @58 Color list box odor White o3 select codalocdi G:’f,\’)ﬂ%@i Apply & Close
button o click cp6ols Options dialog box o> OK c3aoph: click soodaubilechi slded
AutoCAD drawing area c» seghteposeoma: | sagespigbagcifi 0oslobd [goorcd
ommdem drag saaaé(G: command window egpadapaiomdedh sisldadeé Tools—>
Options->Open and Save tab—>Object ARX Applications sss05e Command

InvokeeAppIy—)OK click cpboodli slBqf 8svacded [gberecaodeonolo:

op Start AutoCAD 2005
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Cunent profie:

<<Unnamed Profie>>

B5 Curent drawing:

MewDirawing. dwg

Files [ Display Upen and 5@'-/{3VE‘_I:‘-Io-t::_arj’dfitlJis;}i75_I,Jstem“;:‘U.sre.riF‘referer‘ncesi Dfaﬂ.ir@ En;—.léctlorj _meH-‘:sé

“\wfindow Elements

[ Display screen metu

Display scroll bars i drawing window

£_ Colors...

v ¢ Display resolulion

@ ]
L

Arc and circle smoothness
Segments in & palyline curve
Fiendered object smoathness

Caontour lines per surface

~Crosshar size

13

e i

() (o )

~ Reference Edit fading intensity

a

Apply
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M | ¢ (o 29)
v

[Modeltab Layout tabs
File Edi File Edy
odea I_ayoutj Moda|} Layout‘!‘
JCammand: Command:
Windows E lement;
| Madel tab background
Color. | I Black
: W Fed
[ peaam ) [Ovelon
[ Green
y = [ Cyan
Apply & Liose Cancel
[ s ] [ -l Blue

M tdagenta —
E-F
tBlaCk

- |

Sefect Calac..
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> Control 2D Drawing Views

2% Q

. 2D drawing oooa8 93620805 (3pd3s0eE m8:mblgEaesant drawing o3 Magnify (zoom)

w03d) 3p0q0leddi sleewnds drawing oo sacbealEiecyad ssepelptifoypdg et drawing

o Pan (shift) cod:fo3piqolecSt AutoCAD ¢> drawing view mda5d dbsadjd)s slgnt:
f3pd8&eowo¢ (o) Pan a view ( J) Magnify a view § () Pan and zoom with the Aerial
View window 38 meadgaBqoloncSi eam&:f§ 1 & (0. 09) enfgoonto) drawing o3 drag

L

QQ@: Pan cxg&@éqem&:

» To pan by dragging

<

ViewPan->Realtime o3 click «p6f: hand cursor . eolangé drawing object o3
drag aé@ drawing area co¢» @p%oao%sgﬂeo:c@qcﬂmu%u o (o- o@) (')‘%@éd]ll

Jo Start AutoCAD 2005
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Redraw
Regen
Reqen Al

Zoom [

Paint g

Aerial View

Clean Screen Chrl+0 Left
Right
Up
Down

Viewports
MNamad Yiews...
3D Yiews

3D Orhit

Hide
Shade
Render

Display »
Toolbars...

St Pl Plar
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To pan by specifying points

View-Pan-3Point o click cod[g: base point ox623 Pan to point oxdacdooobecieoigé
drawing object o> new location s8a3 move cpdagdladgedsi

To zoom by dragging

View-yZoom-3Realtime o} dlick op0: pointing device A+ edlangt sidlaieantdod
Gmt}%oo? drag aéqlqé drawing object v zoom out Bogcgo:g)or]u o (o. OQ) or%@éo’]n
sacoTa%@%@: canédad drag 3590398515 Zzoom in @50’10%6903" zoom mode mes

L L <] L .

080‘5:;:]8616 ESC key 0386¢h

(o- 29)

W 4] p 2]\ Model [t Flact Plen | el i Y

To zoom in to an area by specifying its boundaries

View->Zoom-Window o3 click coé3: drawing object eol'engos(G: rectangular area

Jd
mdacddel 538 area adenclofeso) drawing object §,528059208:03 w(3}d) [gevteach
Lt 4 s L L g 1

5 (o- Jo) H3eSh

o]

P Start AutoCAD 2005
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» To display the drawing extents by zooming

5 (0. Jo) enlgoomo3d maginify [gdoga:iqé View-Zoom 5 Extents o3 click codfoqsscli
current viewport SJeoych drawing area cde safdfe: fit [40p0donbes display codfgeuedt

cB&wdi o (:). og) (ﬁ@é(ﬂn

» To zoom to a new area using the Aerial View
window

View-3 Aerial View o3 click co6[: Aerial View window el congé view box aden click
gk cross arrow césedlcld8éectn § cross arrow ciegeoiqé drawing object o
drawing area od¢»> Pan [goesclocdi sleosa) cross arrow 3 click cpoe€ pointing arrow
% (}t)%@@ﬁgngquﬂn pointing arrow RY Pmcbones direction =8 move codeotecidef
rectangular area o coa:em;aga:@: drawing area odo» drawing object oo zoom in
[§6ozm1ea0li poonod direction &8 move cpd3gteor, zoom out {gbazotdlecdi zoom |
operation o3qGacaé right-click cobclu

Start AutoCAD 2005 g5
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A T e 3 MR
'ﬂ’ Aerial View - C:\WProgram Files\AutoCAD .|
Yiew Cptions  Help

® Q@

¢ (0 Jo)

o.9 Specify a 3D View

AutoCAD g 3D drawing object coog?o%ag : View gaqi*:@j'[:% display oeﬁ@éaﬁmosg%qg
command saupigefgeie? madgededlonddi sdmergé 3D view (3) doresplsdiclon

(o) Parallel projection view ( J) Perspective view § (p) 3D Orbit view Bgdfgclorcdi

To use a preset 3D View

com&f 1 0 (0. ) 9olgoom:od 3D madel dac’ 3D parallel projection view sopg
display cp6[mp3qeseati View->3D Views->SW Isometric o} click cxdfpqpocln slded

3 (0. ) e0cddunlgooniodeacits 3D view ddelgtsago:di

N Start AutoCAD 2005
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Redraw

Regen

Regen &l

Zoom

Pan

Aerial View

CleanScreen  CtrhG

Viewports

Mamed Views. ..
Viewpoint Presats. ..

3D Orbit Viewpoint
Plan Yiew

Hide

Shade Top

Render Battom

— Left

oolbars... Front
Back
S‘E Isametrig F
NE Isometric
W Isometric
= X
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» To set a view with a viewpoint coordinate

View-3D Views> Viewpoint o% click co&dli & (. jp) 9’3[900’3:0?990938: compass g

tripod colangf viewpoint o3 compass odeo click 3§ wobecdeviadqulorcdi cross

mark o3 secproasdEiaden oBmechBaieg coragmql view direction o saedlBlgéan
Q L 4 s P 5 4] L ",

Slechn center O%c;epogegxqcc: Top view @o%og}:meo’lll

X

R, Start AutoCAD 2005
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P odmdSe] cross mark o} compass ¢» outer ring ceepobesend move cobeorogrel
; ; 9 ¢ ¢ T N g o 0 s 0 o
drawing object o} cemcimes cvslogpacd View gagEaendl & (0. jg) Flogeddh

» To set a view with two angles of rotation

85pb:en viewpoint sagycd view direction angle eczo3 command line mes §odaopecs
f] < . e <
qilocSi & (0. J) Bozpadh

view direction
viewpoint

angle from XY
plane

angle from X axis

Start AutoCAD 2005 o
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» command prompt ¢> VPOINT command §cdcopG: Angle in XY plane from X axis:
75 § Angle from XY plane: 45 303 enter cpoeotqc 3D View 9200603 & (0. f6) ofg

oD FOES BE Slocd
el

Opening an AutoCAD 2004 format file. T:
Regenerating nodel . é
AutoCAD menu utilities loaded.

SiCommand : VPOINT

HZ-I Current wview direction: VIEWDIR=-299 . 5111,258.3753.111 9364

= Specify a view point or [Rotate] <display compass and tripod:: E
o [Enter angle in XY plane from X axis <139»: 75
Z |[Enter angle from XY plane <16>: 45
g Fegenerating model .
3
o

Command : — _ [€ Tl @

e Start AutoCAD 2005
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» To use 3D Orbit view

@

8anbalcobenan 3D model odac3 3D Orbit command seob:(gfG: model o3 rotate cpd

4 L

[3e5clectn View->3D Orbit of click cobclech sleqé 3D Orbit mode cdcBeepadanfE

5 (0. Jn) eogeomchmacit: 00dd&:(chicden echdiecn (4) acdeoy ool

ACN?)
> 9’380(5(%8:093 drag sgevromg 3D model ex direction s dpden més@tﬂc\%éeosn %065
< oQc

25 gbaoeoigteé ESC Buewpod ENTER key 3860l & (0. Jp) oo model o3

G2Q0 0D t

&
3D Orbit s’aa?:@@: rotate cmeﬁ@ocmmo% o (o. Jo) g}@étﬂu

Start AutoCAD 2005 PO
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».6 Display Multiple Views in Model
Space

u drawing area o6a0> model 0623, view sadpdpd display crdfgeiéeé Model tab o3
Goo[f: drawing area of multiple rectangular view soplgbesent 8c50&:(G: saodifged
sltﬂcou)u 53803 view Jrecyc model space viewport ecpcesl Sloodi & (0. @) a3fogaadh

c@Do| |o&®
(elo18lels) cOo000
\NQOOQ/ 0000/
o@o] o @Bo
left night
oG o
@& |- B |- &

vertical above below
& (o o)
P drawing ssentecyer multiple viewport soyddaingsngé drawing detail soped

zoom in codfopbepxd 1 single view o pan codoisiqemsecy secrbgbasobomagigacl
View > Viewports >3 Viewports o3 click cobdlechi & (0. po) aBjogpddl

| g s1BeE & (0. 09) wrealfgdod 2D model 06303 (0. po) golgoonaysedié: viewport (3)
23 oedlfgedqoloncdt 85p5i view sadfpdrmacbifgoosiomadeon, dwmenget gpecy,
GogSenomed]ecoi
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Redraw
Regen
Regen Al
Zoom »
Pan »
Aerial View
Clean Screen Chrl+0
— Narmed Viewports. .,
Nared Views, .. -
3D Views b NB'-:V Yiewports. ..
3D Orbit 1 Viewport
2 Viewports
s E———
Shade b 4 Viewports
Render »|  Paolygonal Viewpart
: Objerk
Display ]
Toalbars... Jain

TR

& (o 20)

i

T AT

14 [ 4[> | #]\ Model { Bth Flocr Plan /

m

(WL

o
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CHAPTER 2

| JUUS
USE
PRECISION
TOOLS

AutoCAD 3dcpdecpencyad dBonjed coordinate data eopoopien:§aleal entry
method eadjedfscd mead(gBeolorcdi point odesepod data copbew:dod command prompt

ombgeclaxeé drawing area od¢» pointing device § click cp6f: data entry cpdcBqoocd

command line ¢> coordinate value eogo%: %ogooéeo:qémé:qo']mcﬁu AutoCAD ¢ modigpeed:
coordinate system (4) <o (o) Absolute Cartesian coordinates ( ) Relative Cartesian

coordinates (p) Relative Polar coordinates system § (g) Direct distance entry o3clon

Use Precision Tools ol
R



;o Use Coordinates and Coordinate
Systems

» To enter Cartesian coordinates

point oc>6a9e0p05 coordinate coy wodecbeviqucdaded drawing origin(0,0) ssecdmes
OC L L < 2 C' C e o C c o <
Bomcdecholoddl Sosdmmad ddm 2D wadet (X,Y) g6 3D eoBac (X,Y,.Z)
@56]03<.5u origin § promadg meoTooo%go%o}seo%é:mm c;ogoroE positive value Gogm@o%
[y £ c < TP < [ C c Q cC O €
200260encll 22605063 OFIgIN §,p00m05 (4) Wsd | seed] M (6) VW§EYIResOIOYC
538200503 (4,6) ceqrornd AUtoCAD ma3dlonddi poes command line ¢» absolute
coordinate eozeeadigf: macdespecidet AutoCAD mes gbrefpéiondefopéia’ Qeot
N a o Ly
eo0lon & ( . o) Blogpach

© |Regenerating model .
wd [AutoCAD menu utilities loaded.
Z lCommand: LINE
= lenecify first point: -2,1
% Specify next point or [Undal: 3.4
g Specify next point or [Undol:
= |
8 Command EATNREY j
Y
4
PEET
/ @
; ¢ (o)
-2
=X T X
<Y
P relative coordinate coyBemaiffecSs8ef esocdedienedsy, coordinates d3sacaendli
| LTS L L L 4 L 4

4

relative coordinate o&:3esné @ sign o3 coordinate copegen essviqulecdi poen

o9 Use Precision Tools
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- R
Fegenerating model .

AutoCAD menu utilities loaded.
Command: LINE

Specify first point: -2.1

Cpecify next point or [Undo]: @5, 4 :
Specify next point or [Undol: ‘i

|

COMMAND LINE

™

E : X

5 ()

» TJo enter Polar coordinates

Polar coordinates ¢ocopd: Cartesian coordinates <3¢ absolute (measured from
origin) § relative (measured from previous point) coordinates =3[3: §exclon 80564,
6 8 - S = Qc Lo & C c
format do» distance<angle § @distance<angle cj[géclosabn distance oo gbielopés
25 1 angle o angular (counter-clockwise) degrees ol pow> @6<120 o3 sepeoadad
03Bt egacha: enter axd3o) saecdmesmalgffi X- axis edl'vn 120 degrees (counter-
L L L e o 4 4
clockwise) copdBch(B: (6) wogdegpd8od gbielopEimbepiicdageuigndh rectangle
530303230% relative Polar coordinates esl:‘?é:% saagcx%eslm%qo'}oau%u o (J. 9) O%Eéoflu

Use Precision Tools o6
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8
Coﬁﬁéndf
| -recify first point: 2.2
& |Specify next point or [Undo]: @8<0
= Specify next point or [Undo]: @6<90
%' Specify next point or [ClosesUndo]: @8<180
g “pecify next point or [ClosesUndo]: C %
% |~onmand: _
8 LIRE Specify first point: (€ T}
¢ (s9)

To enter 3D Cartesian coordinates

3D Cartesian coordinates o3 entry cobspbio 2D Cartesian gpbigsecyondlon (X,Y)

a N

men (X,Y,2) 660[g8cloncdn 3D Cartesian coordinates espspb:y 3D plane odeo g

ey

30 (U

c C. o Q o "I C o
oeloptidy sagcecieiadlondd ¢ (). )

9) Fegeech

| i i

Fegenerating model .
wi {AutoCAD menu utilities loaded.
Z |Command: LINE
= |Specify first point: 3,2.5
fan T - . .
¥ 1Specify next point or [Undo]:
g Specify next point or [Undo]:
=

0.0.0

- Eummand |

A &

6 (49)

P2
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WCS origin point

{
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b
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%
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» To use the coordinate filters

3D Cartesian coordinates (X,Y,Z) S’aa{uzgﬁé:d‘% powsmesy 3D Box object 005??:1_
s0&0Bmebeseper 0058610203 XY plane edTeradfgolectn view point o3 Top
view mes 3D view cdacBelgisf: View3D Views>SE Isometric o click codch
Geeomgé Command line ¢osescd command eogesild: & (- B) ¢o[geonsoy 3D box

N

OJ%)%O%S%)LQQQSII

Regenerating modei.
AutoCAD menu utilities loaded.
Command:

Command:

Command: _-view Enter an option [?/Categorize/lAyer
state/Orthographic/Delete/Restore/Save/Ucs/Window]: _seiso Regenerating model.

Command: LINE
Specify first point: 0,0,0

Use Precision Tools po
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Specify next point or [Undo]: 3,0,0
Specify next point or [Undo]: 3,3,0
Specify next point or [Close/Undo]: 0,3,0
Specify next point or [Close/Undo]: €

Command:

LINE Specify first point: 0,0,5

Specify next point or [Undo]: 0,3,5
Specify next point or {Undo]: 3,3,5
Specify next point or [Close/Undo]: 3,0,5
Specify next point or [Close/Undo]: C

Command:

LINE Specify first point:
Specify next point or [Undo]:
Specify next point or [Undo]:
Command:

LINE Specify first point:
Specify next point or [Undo]:
Specify next point or [Undo]:
Command:

LINE Specify first point:
Specify next point or [Undo]:
Specify next point or [Undo]:
Command:

LINE Specify first point:
Specify next point or [Undo]:
Specify next point or [Undo]:

VE

[ENTER}

[ENTER]
<click 1>
<click 5>
[ENTER]
[ENTER]
<click 4>
<click 8>
[ENTER]
[ENTER]
<click 3>
<click 7>
[ENTER]

[ENTER]

<click 2>
<click 6>
[ENTER]

Use Precision Tools
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Command: CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: .X
of MID

of <click 1>

(need YZ): .Y

of MID

of <click 2>

(need Z): 5

Specify radius of circle or [Diameter]: 1.25

Use Precision Tools Go
[



Command: CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: .X
of MID ' '

of <click 1>
(need YZ): .Y

of MID

of <click 2>
(need Z): MID

of <click 3>

Specify radius of circle or [Diameter] <1.2500>: 1.5

Go Use Precision Tools
——



;.4 User Coordinate System (UCS)

AutoCAD ¢ coordinate system (2) §e? seobifgSloscSi oodacn World Coordinate
System (WCS) Seslop fixed system méslgd: oysoros User Coordinate System
(UCS) c3sslo3 movable system clon WCS o> X axis o> horizontal 1 Y axis o vertical
[988: Z axis o> XY plane o3 coonfocboyescy axis cdsfgdcloncdi X-Y axis soy [§o50)
G@gpo% origin C\céeﬁor]mcﬁu ucs c%e&e@;é:eo:@&m drawing 0'35?81‘ ooc%éjL ga%o%cra?eé:
sopBechmalen apbmeadloadi egaadf: 3D Bewxdd rotated view soyenedec UCS
o> rotate 036@0:@6:000 Snap 1 Grid | Ortho mode Gogo% C\%U%CUECGOO'JD%C% new UCS
UCS 3 dsdomom smatelgardlondiu UCS icon eqen style (3) g§iclosddi & (). g) o3
[r3e50h UCSICON command seadfg[8: 2D sdewnos 3D UCS icon o3 display codfgads
203 SHADEMODE o3s303:(gfG: shaded UCS icon o3 display cpbededloodd

Use Precision Tools GJ
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current UCS origin ¢» icon o> display [8e59¢ icon odeo plus (+) wecbomds edl eg
SlecSi current viewport §, ;dSonadesmadelgsniencdl 38 plus (+) ooecbon eedl clope

Z Z
A
g <" k ¢ (e
X
2.4

2D UCE icon 30 UCS jcon shaded UCS
icon

To display the UCS icon at the UCS origin

View-3Display3UCS Icon->0rigin o3 click coddli On o3 check cobeon:qé icon oo
display [gdesdlechn Origin o> checked [gbesqe icon oo UCS origin ¢x§esoxdlon ¢
(1 00) AT

Redraw

Fegen

Feqgen Al

Zoom L4
Pan [ 3
Aerial View

Clean Sereen Chrl40

Yiew, » .
¢ (0-20)

Named Yiews. ..

3D Yiews [ 3

3D Orhit

Hide

Shade

Render
o . ; v On

Toolbars... Attribute Cisplay B w Crign

: F‘r‘apertias...lk\
Text Window Fz
1
G? Use Precision Tools



» To change the appearance of the UCS icon

View- Display-UCS Icon-»Properties o click cp6cli UCS Icon dialog box edlaxeé
UCS icon style 1 UCS icon size § UCS icon color eopcd(@obep set codeoicdquloacdi
[Beeomgt OK o3 click cvdalecdi & ( . 00) odagadal

o

MEl®

- UCS icon slyle Previgw —
: (O Cihe : /\ E
| O Line width: : Y g
L _ g% [/\I E
 UES ieon size s i > ,
1 m x>
! ‘112____J 3 :
+UUCS icon color e - S
i Model space icon cofor: Layout tab icon color: |
M Black v H Glue vl |

| o c cj
[ s« k} [ cancal | [ Hep )

¢ (4 09)

P c3bmbspSion command fine ¢> SHADEMODE o3§05c003f8: 2D/3D/0 o0 0962203
eg:cx%qo’]oou%n LLJ (J. :)J) o%@étﬂu

qunerat ing model.

st [AutoCAD menu utilities loaded.
& [Command: SHADEMODE e
; Current mode: 2D wireframe ‘
=
'g Enter option [2D wireframe~3D
= [vireframe-Hidden-Flat-Gouraud-flLat+edges- | E
8 gOuraud+edges] <2D wireframns:: (<Tw} [Z]
¢ (Jr2ol)
Use Precision Tools GG



& (J» 09) 0033€ 0 (). 0) wofgoonioy UCS icon style o3 3D aoes 2D Befgoéaamtondli
2D UCS icon §ojmocbegepan coordinate o3x35Eq¢ Tools>Inquiry>1ID Point o3
select cpdfgs 2D icon esepes click cwdali slade command window ¢ seaceay gendh

()

fOpening an AutoCAD 2004 format file.

B |[Fegenerating modesl .

W [AutoCAD menu utilities loaded.

B8 [Comnand: '_id Specify point: X = 0.0000

e ____‘. = . e

To define a new UCS origin

Tools»New UCS->Qrigin o3 choose cx&fd: box o egmncdaonodeaoysd: corner ¢o
click qlqtcz UCS origin egepom e@o&:og):o']@si & (e 09) f}%@é(ﬂu

(L

o (U 09)

g9 Use Precision Tools
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» To restore the WCS

ToolsyNamed UCS o click oo & (. 09) ealgeomoheedcdts UCS dialog box edl conet
World > Set Current> 0K o% click 0360‘)’)$ o (J, og) mac:}éj[: UCS origin Gé?GPG[Q’JE):

QC L
agaraledgendi

JE1 UCs

Named UCSs [Othogiaphic UCSs ' Sefiing:

Current UCS: World

!
[ Set Current

Previous Details

o () 09)

1~ Use UCS in 3D

] com&fG 1 O (- 96) enfgaomc) object §mdmadesnadely COMEr esepy> Eafgecyy
mc305 UCS odsc? define codevsfmpdqeszoés ToolsNew UCS—3 Point &3 click
64l Breomeé Command line ¢ 5223 command eoaaR§odeopddlecdi

Regenerating model.
AutoCAD menu utilities loaded.

Use Precision Tools 9@
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Command: WEDGE

Specify first corner of wedge or [CEnter] <0,0,0>: [ENTER]

Specify corner or [Cube/Length]: L

Specify length: 10

Specify width: 5

Specify height: 7

Command:

Command:  <choose SE Isometric view>

Command: _-view Enter an option [?/Categorize/|Ayer
state/Orthographic/Delete/Restore/Save/Ucs/Window]: _seiso Regenerating model.

& (J- 06)

Command: < choose Tools-»New UCS>3 Paint>

Command:

Command: _ucs

Current ucs name: *WORLD*

Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World]
<World>: _3

Specify new origin point <0,0,0>: <click 1>

Go Use Precision Tools
I



Specify point on positive portion of

X-axis <11.0000,0.0000,0.0000>: <click 2>
Specify point on positive-Y portion of
the UCS XY plane <9.0000,0.0000,0.0000>: <click 3>

P  command line ¢ seolefgoonioy command coyBosapdfeat & (- 09) wolgeonay

scdt: [Geqeadli

% (J09)

g ¢ cre, 5 g e o o B, s G0
> 8onbslaoofG eopamenmeor; 3D space oden UCS o3 position s»djrajpencon@s d=dspoio)

sopaneadli pogiE: Drawing setup codf: Command line o 33503 command eapc?

oy

§oScopdenidl slBqé mee 0.01 w60y 2D Solid cbacdadeuidlcdgedsi & ( J. on) 03

@é_)of]u

Regenerating model.
AutoCAD menu utilities loaded.
Command: LIMITS

Use Precision Tools Go
A,



Reset Model space limits:

Specify lower left corner or [ON/OFF] <0.0000,0.0000>: [ENTER]
Specify upper right corner <12.0000,9.0000>: 50,40

Command: THICKNESS

Enter new value for THICKNESS <0.0000>: 0.01

Command: UCSICON

Enter an option [ON/OFF/All/Noorigin/ORigin/Properties] <ON>: A
Enter an option [ON/OFF/Noorigin/ORigin/Properties] <ON>: OR

Command: < choose Draw-Surfaces->2D Solid >

Command:
Command: _solid Specify first point: 12,6 < this is point 1>
Specify second point: @30<0 < this is point 2 >
Specify third point: @-30,20 < this is point 3 >
Specify fourth point or <exit>: @30<0 < this is point 4 >
Specify third point: [ENTER]
4
“
<2 !
3
2
% (U om)

>  Soods! THICKNESS command § CIRCLE command c3cd=aad(gG: cylinder ¢oés

L

eonoemoéagof]ecﬁu o ( Je 0@) o%@éor]u

G@ Use Precision Tools
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Command: THICKNESS

Enter new value for THICKNESS <0.0100>: 10

Command: CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 16,10
Specify radius of circle or [Diameter]: 1

% (o)

> 80064] ARRAY command 52a3:[g[§: cylinder o2 40 o3a3dlecSi command line oo
ARRAY 38c5c0p)f8: ENTER §64E Array dialog box edlendl§ Rectangular option |
Rows: 51 Columns: 8 | Row offset: 3 1 Column offset: 31 Angle of array: 0 o%o% set
6 Select objects button o3 dlick cobclecdi ¢ ( - jo) o3oapddh Greomeg & ( - o)
o cylinder o3 click cwdg: ENTER cr%%aqé Array dialog box [g$edl conclecdn OK o)
click coSli 818 & () o) eomadden[geonchmddt: soy quledi
Command: ARRAY
Select objects: 1 found ‘
Select objects: [ENTER]

Use Precision Tools 70
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-4 Rows: 5 N .5 Columns: 8

() Folar Aray

Offset distance and direction " i

Fow offset

Angle of ar

ffet 3 0000 .
Cobumn offset ]3 Qoo

1A ‘_____J
By default, if the row offset is negative,
rows are added dowrwnard. If the

colurn offset is negative, columns are
added to the left.

Select objects

0 chjects selected

o B e s
i Y s e s s o
s s s s o
e e e o e
e e e s I

Use Precision Tools
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@ ¢ ; Q QN c ¢ RN - S
> 803l cylinder sqyBeopdeoiconay box mdsgesme Hilecss Hfraznqé & (J- o)

oolgeonoimddés [gEquleddi

Command: LINE

Specify first point: 12,6

Specify next point or [Undo]: @30<0

Specify next point or [Undo]: @0,20

Specify next point or [Close/Undo]: @30<180
Specify next point or [Close/Undo]: €
Command: HIDE

Regenerating model.

¢ (o )
> som&f 1 memdslaenmen & (. ) rlgoonic) box wmimbedaicoiclectn sai:

ot UCS icon o & () ) 9rgoomcpeecdéfgdeant esepegeotqolecdi sle sadia3
Ba3qoledsi command line mseslgoy command eqya3§oscopaf: d3o3aBf3Eah

o B T

Use Precision Tools 9
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Command: < choose Tools>New UCS5-=3 Point >

Command:

Command: _ucs

Current ucs name: *WORLD*

Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World]
<World>: _3

Specify new origin point <0,0,0>: <click 1>
Specify point on positive portion of

X-axis <13.0000,6.0000,0.0000>. <click 2>
Specify point on positive-Y portion of

the UCS XY plane <12.0000,7.0000,0.0000>: <click 3>
Command: '_thickness < choose Format-Thickness >

Enter new value for THICKNESS <10.0000>: 20

9 Use Precision Tools
E———



Command: LINE

Specify first point: <click 4>
Specify next point or [Undo]: @15<150

Specify next point or [Undo]: [ENTER}
Command: HIDE '
Regenerating model.

' c CraN_ N [y OC e » <
S000N0CH O’)CB?O‘??&:G’BO’EC: (T.) ( D

Q

Je Jg) cﬁi mwo%oao%cﬁo%g eq:ao@éo']n ucs sa:fg:@l@@:

2 s
C’? GOJGCDSJ’):‘?’D.CDEOg).O QU9

o (U )

;¢ Use Object Snaps

| user o> drawing object scydsyesmnéen object eqyendlofay midpoint 1 intersection

end point 3} cbodeddeciesepenyad AUtOCAD § sapcSonmensy sconmargiEyt
PL 4 4 o L 3 (o] IL J o i

Use Precision Tools %G
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object snaps o3eaod(ggrch poes ec8&mbad, vdmecdesapadal qSreoppionda
aéoooej’[: | polyline 0‘)5;3&1‘ midpoint G§q3383§mcaj’lacogo§ aﬁc\%cﬂmcﬁu command prompt

mes point mﬁ?cmézo%& object snap mﬁ%c}:’g user mwo%@o%eozo%qo’]mcﬁu object

snaps list 3[mpbetqé command line ¢o OSNAP c3§cbcopifogpadh Drafting Settings
dialog box eclaxngé Object Snap tab sa00he> snap mode JrdBeay qolaBgecdn &

L L o L

. 16) Hfornddli esncdhorbsndion Odesetientd object edlon point oo snap cwbsiet
J ch L @ § ‘?@ Lo %6]. 4 L L L \l Sl

SHIFT key &5comff: right-click cpbcli shortcut menu eolaongé [Bossp object snap

mode 3 mmcﬁmmeg:mo%qo’]oou%n
L Q L L

IEd Drafting Settings

E_E.TEE.'.':.'_Qd Grid | Polar Tracki_ng_] Obect SHQPQI

[¥li0bject Shap On [F3f Object Snap Tracking On {F11)

Ohject Snap modes

0 Endpoirt Q_'Il [ Ingertion

A U Midpoint b [ Pependicular

O Center T [ Tangent |

2 []Node ¥ [ Nearest

> [ Quadrant & [ Apparent intersection

X Intersechon 2 [ Paallel .
- Extension H

command. A acking vector appeaiz when you move the cussor, {
Ta stop tracking. pause over the point again.

;2 Tao track from an Oznap point, pause over the point while in a
4

[ ok} conest [ bep |

o (U J5)

99 Use Precision Tools
I



» To change the AutoSnap settings

Tools->Options o3 click cxd(G: Options dialog box edlcngé Drafting tab o click apd
(s drafting setting s> b G[Qo&eo:cféqo(]mogu AutoSnap Settings esanodon Marker
Magnet | Display AutoSnap tooltip check box o303 check apodlecin AutoSnap
marker color o3 Magenta coo:dhi [reomqé AutoSnap Marker Size o spSippbifciieos
BobfGe OK o click cobilecdn & ( 1. jg) SBlogasdh

Current profile: <<Urnamed Profiler > Currert drawsng: testZ dwg
| Files V Distlaw | Dpen and Save Plot and F‘ub!ishl! System ‘l_l_]_sgr Freﬁazqugﬂmﬁg Selection|| Profiles]
Autonrar L= s SutnTrack Settings :
Marker Display polar tracking vector
Magnet Display full-screen tracking vector
Display AutoSnap toakip Display AuteT rack tooitip

[] Display AutoSnap aperture bos

Alignment Point Acguisition
AutaSnap marker calor: ®n ¢
to i :
I W Magenta ﬂ WIS :

L O Shift to acquire :
J

~AutoSnap Marker Size —] Apedure Size

r Object Snap Options -

Ignore hatch objects

[ _aKJV}J ((cancel | { ey J{ Help }

(Ur u9)

rCe

P wmges LINE command o38c5eopdf: command fine mes point secped prompt cpéo)
o93leo SHIFT 86coxqf: drawing area o right-click cp6e shortcut menu sl cndledh

Use Precision Tools o6
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eg05(G: Midpoint o3 choose codffieon & (j. JB) oo drawing object oo endpoint esep

sopedlen pointer Beonzeuzet object snap marker § tooltip sdl anoma} sop guledgend
(s 1 i o { ®ge S

Tempaoraty track point
From

Mid Between 2 Points
Point. Filters 3

Endpoint

' Intersection k

Apparent Intersect
Extension

Center
Quadrant
Tangent

Perpendicular
Parallel

Mode

Insert
Nearest
MNone

O=nap Setkings. ..

9 Adjust Grid and Grid Snap

>

To change the AutoSnap settings

grid limits §oocbodbeioy drawing area o>bacdon rectangular dot pattern oxdaad

Loy v]
L L

grid o3l oxolow grid o%saoﬁl"_):@l@&m grid paper ooocstncr% drawing object Goch_:o 3?500'3:

omgorcleadi Tools-y Drafting Settings o3 choose coof@: Drafting Settings dialog

Use Precision Tools
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box ecTaongé Snap and Grid tab->Grid On check box o8 check coSfE: grid edl'eon

esné cobadqoloacdn grid X Spacing § grid Y Spacing value eepal wEeordoMegEew:

Gedloncdi (- o) Rgedel

Opening an AutoCAD 2004 format file,
Regenerating model.

AutoCAD menu utilities loaded.
Command: LIMITS

Reset Model space limits:

Specify lower left corner or [ON/OFF] <0.0000,0.0000>: [ENTER]
Specify upper right corner <12.0000,9.0000>: [ENTER]
Command: '_dsettings < set grid and snap spacing >

it Drafting Settings

7ghgaémﬁa.@ar Tracking: Dbjzct Snap|

Sniap On [F3) Giid On F7) _

r Snap ~Gid y

I{ Shap X spacing: {n.sann [ Grid X, spacing 0.5000

| o

i Snap Y spacing: 10.5000 Grid ¥ spacing: 0.5000

i

: Angle: : S

| ~Snap tyupe & style

i : G.0000 “

| Kbose L EL S gy 5 (o)

. Y base: 0.0000

: {® Rectangular snap :
. O lsometric snap

- Polar spacing 3

" Palar distance: 00008 O Polasnap

[ DKQ [ Cancel ] [ Helip J

Use Precision Tools ML
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Command: CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: <click 1>

Specify radius of circle or [Diameter]: <click 2>
Command: [ENTER]
CIRCLE Specify center point for circle

or [3P/2P/Ttr {tan tan radius)]: _ <click 1>
Specify radius of circle or [Diameter] <0.5000>: <click 3>

Command; PLINE

Specify start point:

Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:

Command; TRIM

Current settings: Projection=UCS, Edge=None

Select cutting edges ...

Select objects: <Snap off> 1 found

Select objects: ) [ENTER]

Select object to trim or shift-select to extend

or [Project/Edge/Undo]: <click outer circle>

Select object to trim or shift-select to extend

or [Project/Edge/Undo]: <click extended left segment of polyline>
Select object to trim or shift-select to extend

or [Project/Edge/Undo]: <click extended right segment of polyline>

%€ Use Precision Tools
I
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al

X

Command: '_dsettings < change Snap angle to 30 >
]
Snep and Snd ol Tracking. Tojet Snag)
Snap On (F9) Grid Dn (F7)
- Shap ¢ Grid

| Snap X spacing 0.5000 Gifd X spacing 05000
Snap Y spacing: 0.5000 Giid ¥ spacing: 0.5000 -

=1R=
(]
(=) Qo

e o

Angle:
 Sriap lype & stile .
¥ base: .
(& Grid snap ) (f (J J@)
Y base; .
(& Rectanaular snap i
% O Isomeliic snap

~Polar spacing
Polar distance: 0.2000 ) PolarSnap
\.

oK lE  Cancsl melp

Use Precision Tools Go
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Command: ARC

Specify start point of arc or [Center]: C
Specify center point of arc:

Specify start point of arc:

Specify end point of arc or [Angle/chord Length]:

Command: LINE

Specify first point:

Specify next point or [Undo]:
Specify next point or [Undo]:

Command: ARC

Specify start point of arc or [Center]: C
Specify center point of arc:

Specify start point of arc:

Specify end point of arc or [Angle/chord Length]:

Command: LINE

Specify first point:

Specify next point or {Undo]:
Specify next point or [Undo]:

Command:

LINE Specify first point:
Specify next point or {Undo]:
Specify next point or {Undo]:

Command:

LINE Specify first point:
Specify next point or [Undo}:
Specify next point or [Undo]:

6o

<click 1>
<click 2>
<click 3>

<click 3>
<click 4>
[ENTER]

<click 5>
<click 4>
<click 6>

<click 6>
<click 2>
[ENTER]

[ENTER]
<click 7>
<click 8>
[ENTER]

[ENTER]
<click 9>
<click 10>
[ENTER]

Use Precision Tools
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Command: ARC
Specify start point of arc or [Center]: €

Specify center point of arc: : <click 5>
Specify start point of arc: <click 10>
Specify end point of arc or [Angle/chord Length]: <click 8>

Command: TRIM
Current settings: Projection=UCS, Edge=None
Select cutting edges ...

Select objects: <select line 7-8>
1 found

Select objects: <select line 9-10>
1 found, 2 total

Select objects: [ENTER]

Select object to trim or shift-select to extend

or [Project/Edge/Undo]: <Snap off> <click 11>
Select abject to trim or shift-select to extend
or [Project/Edge/Undo]: [ENTER]

Command: FILLET
Current settings: Mode = TRIM, Radius = 0.2000
Select first object or [Polyline/Radius/Trim/mUltiple]: R

Specify fillet radius <0.2000>: [ENTER]

Select first object or [Polyling/Radius/Trim/mUltiple]: <click 12>

Select second object: <click line 7-8>

Command: , [ENTER]

" FILLET

Current settings: Mode = TRIM, Radius = 0.2000

Select first object or [Polyline/Radius/Trim/mUltiple]: <click 13>

Select second object: _ <click line 9-10>
Use Precision Tools G



o (U 90)

@? Use Precision Tools
I



;-6 Use Angle Override

u drawing area edl'eo seechondacigecil: next point sa0305 angle o3 override cpbeo:
€€ left angle bracket ( < ) § angle Boegpevguleddi & (. o J) ¢o angle override
maXfgsesiad eulfgeonclondd 1 sapaniozpdclk

2

: point:

| Specify next point or [Unde]: <60
| Angle Override: 60

l Specify next peoint or [Undo]:

| Specify next peint or [Undol: <300
H Angle Override: 300

i ASpecify next point or [Undel:

lSpecify next peint or [Close/Undo]: _

¢ (U eJ)
Command: L
LINE Specify first point: <click 1>
Specify next point or {Undo]: <60 260 (2) 20305 direction o3 60 50§
e lock C\gﬁacéocamnﬂu
Use Precision Tools Eg



Angle Override: 60
Specify next point or [Undo]: <click 2>

Specify next point or [Undo]: <300 5005 (3) secped direction o 300
8083 override cpoeoiomCldi

Angle Override: 300
Specify next point or [Undo]: <click 3>

Specify next point or [Close/Unde]: € 2005 (3) § %00 (1) BBgscdeo:
Slenddi & (). o) Blogpdcl

Specify Distances

To enter direct distances

= ~ C Q cC o No ~ 8 oy ~ : ) C C Q N
drawing area cogosevan (2) %sjmma‘?cﬂq_u w8saem (2) 96, direction cooecgpadengo)
$2030%260:006203 B3 Wodecdena€qt & (. pp) eredlgeonial gee0d (1) egepen
click gf:22005 (2) 2803 rubber-band line 0>623 direction [gevsol 1 click vavdeslom B

4 L s L L

L

comgé Command line ¢ distance s3§odaopdsu:dl sladqt user cBgtoydiefogpésa?

L
~

&3@3 CD’):OF'@II
[&} [¢]

Command: <Grid on> GRID mode o3 ON axSaly
Command: <Snap on> SNAP mode o3 ON cwdali
Command: L gdselopéraciecdi
LINE Specify first point: <click 1>

B Use Precision Tools



Specify next point or [Undo]: 7 000> (2) esepadad rubber-band line
9.9 (7) w$8c3§abeopidl ENTER

Specify next point or [Undo]: sladqt (7) webmqpddoqpreloyriod
Bfragnclin Aluypsom § (90} 4o

NN c _C o _C O C [s] c _C

coropergarbel Babcdec 1 Gepdae

gp20le3gecdi direction g&:eomopdlench

e ik

[

Regenerating model.

AutoCAD utilities leoaded.
Command: <Snap on:>

Command: <Grid on:>

Command: L

LINE Specify first point:
Specify next point or [Undo]: 7
Specify next point or [Undo]:

Al Specify next point or [Undol:

¢ (U %9)
> 8esepunoyrgcdG: object snap sopsochoomdadelpd oyd3omeds)aegegcolendd

object snap a3 Command line e§cdeopdfimadlgeciadel eqadionad: (3) aka3d
2a5(gaéqolonddi poes endpoint 20qC END | midpoint g€ MID wo%wé@fzeo}u
command line object snap ey aaxn: (. o) gosal[goon: Slosed 1 eageonpgpadh

Use Precision Tools &6
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Object snap
Endpoint
Midpoint
Intersection

Apparent
Intersection

Extension

Center

Node

Quadrant

Insertion

Perpendicular

Paraljlel

Tangent

Nearest

None

eorx (. o) Object Snap Command Line

Toolbar

f

&
X
%

.
©

o

o

Command line Snaps to

END
MID
INT

APP

QUA

INS

PER

PAR

TAN

NEA

Objects endpoints
Object midpoints
Object intersections

Apparent intersection of
objects

Object extension paths

Center points of circles, arcs,
or ellipses

Point objects drawn with the
POINT command

Closest quadrant of arcs,
circles, or ellipses

Insertion point of a block,
shape, text attribute, or
attribute definition

Object points forming a perpen-
dicular [normal] alignment

Point on an alignment path that
is paraltel to the selected object

Point on a circle or arc that, when
connected to the last point, forms
a line tangent to the object

Object snap point closest to the
selection point

Turns of object snaps for the next
point selection

Use Precision Tools
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» To offset from temporary reference points

Spphiun mu%wo%?ageo:wszo\psa?o%m%?me§ FRCm object snap method ﬂ% T
G edfgrseecdens, position Bdoodbecdeutadspdidli pows & (. pg) eredllgaoa}
qfelopEiondaayooff: 3905 (3) o3 temporary reference point

\-

gac;.wcm:of]cnmu sragocameﬁa sfaciao% (4) eéqb(ﬁgaqgmo%cfogeo:@: polyline (4-3) 0%

Regenerating model.

AutoCAD menu utilities loaded.

Command: z ZOOM command eotomali
Z0OOM

Specify corner of window, enter a scale

factor (nX or nXP), or [All/Center/
Dynamic/Extents/Previous/Scale/Window]

<real time>: 0.6 drawing window o3(§, cuzclecsu

Command: <Grid on> Status bar «l'o> GRID mode a‘é ON

cxecc)o']u grid Gogeoprcooor]@u

Command: <Snap on> Status bar cul'o> SNAP mode o% ON
oooh target box o grid point 0263
eonbegdladSocd 33 move adel

Q = 12 Q oy
sesiade grid crgago.moepo']u

Command: L

LINE Specify first point: <click 1>

Specify next point or [Undo]: <click 2>
Use Precision Tools Go



Specify next point or {Undo]:
Command: PL
PLINE

Specify start point: FRO

Base point:

<Offset>: @5,3

Current line-width is 0.0000

Specify next point or [Arc/Halfwidth
{Length/Undo/Width]: W

Specify starting width <0.0000>: 0.5

Specify ending width <0.5000>: 1

Specify next point or [Arc/Halfwidth
/Length/Undo/Width]:

Specify next point or [Arc/Close/
Halfwidth/Length/Undo/Width]: w

Specify starting width <1.0000>: 3
Specify ending width «<3.0000>: 0

bg

[ENTER]

polyline aecdcdeedseoiondl

polyline sacpcb start point o3 FROM
method o8 saad(gecidh

target box oigpiefopiedan
Midpoint egepes click cxblu

Q c _C c

ENTER key cec%com copeo (3) ssep

L 4

mes 200> (4) DBondBydefopts

mée@oé:oﬁ:mo%ogo:o’]@u

poiyline width o3 change [o3p50lechn
polyline § ;2065 ep0> line width

polyline & seadesepon line width cla

<click 3>

polyline width 3oeecS (3) epepores

elgo€zolecd
starting Ine width or% (3) cllﬁo%cno:or]ll

endi..y Ine width o3 (Q) coxcl

Use Precision Tools
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Specify next point or [Arc/Close/

Halfwidth/Length/Undo/Width]: <click 5>
Specify next point or [Arc/Close/ ENTER key ooddln sldeé & ( ). og)
Halfwidth/Length/Undo/Width1: @3@000:0’}930% 5:9@@:38920']@"

- & (U9,

o Specify Intervals on Objects

» Toinsert points at measured intervals on an object

Draw - Point-» Measure o3 choose «»&[: line 1 arc | circle 1 ellipse s3ewa5 polyline
o) select cwdolesii command prompt mes interval length a3ecych length o3

L L
00Becha) point eopal click geoiqe AutoCAD ooes specified interval ecgen point
copod place apdeusdladecdi

=

Use Precision Tools 0o
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To insert blocks at measured intervals on an object

Sebel user oves insert cbatad block Boegl create cxbeaonqoleddi Greomel

L L s i d o

Draw->Point—Measure o3 choose co5fE: line 1 arc) circle 1 ellipse BSevrcs polyline

baad select cvbdlecdi command prompt oo b ( block B383c3lonaS ) Bereégndcopd[é:
L L L J L L L L i

insert codecd block & s00p538cdpiecicli object eayod measured object § align

cwbeorgtel Y d3dadeopddl rotation angle o3 0 conges N cd§odcopdol command

prompt oes interval length Becod length cdooddedioy point eoys3 dlick geo:qt

AutoCAD oes specified interval sogen point ecgo? place axbeoidladgecdi

To insert points to mark equal segments

°

Draw->Point-> Divide o3 choose cx6fE: line 1 arc) circle : ellipse s3ocpos polyline cds

C

Q c ¢ C Q [ C [y
R select ngo(]@oou command prompt o> segment FEQIPRPDMOIR) HAIDOPCOIEC

Do

segment oméagéien point cdadgeuicledsed

To insert blocks to mark equal segments on
an object

C\%sa(%qg: user omes insert 00563603 block 0%836][8 Create mﬁooo:qor]acﬁu @:quﬁ*

L L L] L L »
Draw-»Point- Divide o3 choose co6[f: line 1 arc) circle: ellipse a3eunds polyline oods
o3 select codlacdi command prompt ¢o b ( block 3a3c30lodd ) Bavgtadoonifls
insert codeds block §grepdalgcboopdenich object ecpad measured object 3 align
wéeorgeel Y o3§odeopadh rotation angle o3 0 congiEed N o%%]o%ooéo']u command
prompt mes interval length Bemds length 3oodbecho) point saza’ click gecqd
AutoCAD mes specified interval soyen point 9030% place cmgf)so:o"icﬁéeu%n

90 ' Use Precision Tools
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G Extract the Geometric
Info_rmation from Objects

To obtain distances, angles, and point locations

AutoCAD s drawing object Gcgeq:agofjsaé]g) 031%@0’350%@?}(;)803 OSEED af%m%,o%qd:

Q . -
0o Baedoloddi Pavojecrdtgecion coordinate s2ed5 (4,5) oot 1 slevonct

(6,5) conii qése@oé:q’mgém 6" con: oopd[gé object property cop0 0deavH[IR <

ool slo [gEGcBom§at [gEquoech vcesds DIST command cdsayanfgpiqesot)

DIST command o:»adef ogjse005a3 pick cpdc3cbodenecd (2) a8 2030996015600 ~

oodgoheooloacdn 6 { | BloroSdli X axis anes counter-clockwise direction o3 =
3028 2 J 90 O $ -

angle Ba3&omqeodl clockwise Beéecn (360) So§dm sdBomsadecontlgbolecs

Command: LINE
Specify first point:
Specify next point or [Undo]:
Specify next point or [Undo]:
Command: DIST
Specify first point:

Specify second point:

Use Precision Tools -2
A———

<click 1>
<click 2>

[ENTER]
DISTANCE command o3szad[g(S:

L
C

qjprefppiongpdy Repopdloci

<click1>

- <click 2>

| g { o C Q
sleBqé 99005 (1) § 92005 (2) Blogoor .
s'aogos’aeo:% ecmcf:eogo% AutoCAD o
g)@u:c@é@@&ﬂmo%u mo%coocnepewm

~ Q =N 0O C <
G)’)-O?G’BG@QO‘OJO? (eiO’EO’)@@U’-]II



Distance = 4.1044, Angle in XY Plane = 27, Angle from XY Plane = 0

Delta X = 3.6463, DeltaY = 1.8844, Delta Z = 0.0000

Delta Y

g il
b DeltaX —

; N g Lmne ST ananG 1.0

Zagenerating model.

“LoCAD utilities loaded.

tommand: L

_TNE Specify first point:

swecify next point or [Undo]:

“necify next point or [Undo]:

command: DIST

‘pecify first point: Specify second point:

. istance = 4.1044, Angle in XY Plane = 27, Angle from XY Pla

~nlta X 3.64463, Delta Y = 1.8844, Delta Z = 0.0000

Command: _ S

msmoslonélgermecry AutoCAD &, Geometry calculator sefopédhi CAL command
omalqf AutoCAD oo built-in loy calculator of ssl'obhomlgédlorcdi CAL command o3
Point calculator sae§>$:>5:c8slcﬂom3u poen ggseodoogl: 0053C:m0as gpislot:

OO@G@’){?(D SOCOO O'JOJQDO']OII S’BBOO’DOC°DO‘D§ Qe G@’JC:&L B’BCDO.)B’B O'SO%O'CLS EDO’)CDO‘.’O?

cog, ¢ N Q¢
e.e@oc.q samwems@spm ooocoo.,@ G<§9mcou®mcgc 0I00 agqcoaws%qc CAL
~

command $adaadqolonodt & (4 96) oBfogpach

[+

¢ ' Use Precision Tools
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Command: C

CIRCLE

Specify center point for circle
or [3P/2P/Ttr (tan tan radius)]:

Specify radius of circle or [Diameter]:
Command: L

LINE

Specify first point:

Specify next point or [Undo]:

Specify next point or [Undo]:
Command: C

CIRCLE

Specify center point for circle
or [3P/2P/Ttr (tan tan radius)]: 'CAL

oo%sa?og (1) e§q30c§ click Qg&ﬂu

<click 3>
<click 4>

[ENTER]

AutoCAD Geometric Calculator mode

~ 0 _ C
G)O?OCO’.)’DO.-]II

Initializing ... >> Expression: (CEN+MID)/2

>> Select entity for CEN snap:

>> Select entity for MID snap:

(6.49828 6.2567 0.0)

Use Precision Tools oG
I

target box $053050058¢:

30

click c\g&.ﬂu

qBrelop: (3-4) o dlick oSl

& coordinates coom oglgeo)%c%at\)egﬁ
o O ®
orﬁ%é:é{po%gaefog (5) olow



[

Specify radius of circle or 5605 (6) o3 dlick cpo0ln slBeé &

o
[Diameter] <0.8645> (- 96) E sopci

l el ey e B R PRy T i B o N R S |

AutoCAD - Cnmmandime Drawmgl dwg

AutoCAD utilities loaded.
Command: C

CIRCLE Specify center peint for circle or [3P/2P/Ttr {ten tan

Specify radius of circle or [Diameter]: i
Command: L

LINE S8pecify first point:

Specify next point or [Undo]:

Specify next point or [Undel: ' !
Command: C
CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan

Initializing ...>> Expression: (CEN+MID)/2 i
»>» Select entity for CEN snap:

>» Select entity for MID snap:

l (6.49828, 6.2567 0.0)

Specify radius of circle or [Diameter] <0.8645>:

J1

Command :

29 Use Precision Tools
]



I coogscn KecIoHH

C
o)
L
o Q c
OMOCOIM mm@mms&mqjczomm59§cha§ 2 s'\agsan 200 0{)’ RAD function g
©

™

{ AutoCAD utilities loaded.

| Command: C -
CIRCLE Specify center point for circle or [3B/2PB/Ttr (tan tan
Specify radius of circle or [Diameter]: 2.456

Command: CAL

Regenerating model. ﬁ

HInitiglizing ...»>> Expressiocn: RAD =
i ~> Select circle, arc or polyline segment for RAD function: G
3.456

Comngids T R Y |

¢ (U 20)
Command: €
CIRCLE
Specify center point for circle 0m3E:30305 sBmedimdand click
or [3P/2P/Ttr (tan tan radius)]: beordln
Specify radius of circle mgtio0d 3.456 wsb§oy 0c53&mbs
or [Diameter]: 3.456 ag@:ago:d]@u

Command: 'CAL
Initializing ... >> Expression: RAD

>> Select circle, arc or polyline coreo00RfGroyicy 0cddEq saosiedl ¢
segment for RAD function click c60li sleBqt 005314 z0gE1005¢2

RAD oes srae@g.peo*‘cﬁog r}@n

> maegooraimEfgermen object mds Bewrod moamnddo; defined area oy e
L L L A - Q

L
£

¢ 0 C ~ O o [ o)
qqueo']c.ogj $p08 soh total area waney defined area 009§ ooo,ogeqw’)crg Crleplielav
<

:Dcf:} 00@96] éqcme new area oaepcusp’]oow 1o (J. an) O‘%@é(ﬂll

Use Precision Tools o
A —



Command: AREA

Specify first corner point or
[Object/Add/Subtract]: A

()2

object area gnclecdu

area 035?03 add coéilecds

e

& (U 90)

Specify first corner point or
[Object/Subtract]: ©

(ADD mode) Select objects:

Area = 30.3562, Length = 32.8540
Total area = 30.3562
(ADD mode) Select objects:

22 -

. coy
object »es¢, area

3o

add cxgggocﬂu
polyline (1) o3 click 36l slaBqé

object (1) E}‘eglmo% oo%mésa@:}:o%
AutoCAD mgaso:a%cﬁo’}@u

[ENTER]

Use Precision Tools
[



Specify first corner point or
[Object/Subtract]: S

Specify first corner point or e$705 area obso> object (1) area
[Object/Add}: © me§@$ﬁo‘5@o:d}9cﬁu
(SUBTRACT mode) Select objects: circle (2) o3 click cpcli sladed

object (2) area 1 codcopdosiy
Total area = object (1) - object (2)
: 33 AutoCAD mepeusadasolg
Area = 0.7854, Circumference = 3.1416
Total area = 29.5708

(SUBTRACT mode) Select objects: circle (3) o3 click cpodli object (3)
area 1 ochaopdsagasg total area =
object (1) - object (2) - object (3)
B3 AUtoCAD mepeoscdaalg

Area = 0.7854, Circumference = 3.1416

Total area = 28.7854

Use Precision Tools : o0
[



CHAPTER3

autodesk’

AutoCAD®

DRAW
GEOMETRIC
OBJECTS

[y C
AUutoCAD $s30210300800m melgtenamadecmnabdgbeagesdlen | oxdmudeom

% Q

s]s'aelc @o@om commcn geometric object eoyorenad: [Ql@: gécmo;ono']u geometric object

280 lines: polylines | polygons s»edo; line object sapaB el oxdlon circles: arcs 1 spline

g

_rves 1 ellipses ssofomeogmeon curved object s;6ecen0loédlorddi ego05(G: point object

4

meopd: §olooddi & object somddsacpdiomadadqesané Draw toolbar s3ewnos Command
"€ 6003 AUtOCAD encopgeonsclonadi geometric object eopad user oveg §€865E:5E:530n0G
oc ¢ C < Cxn NaNCMC 5 N 0

D8q¢ udean0racd30300o[go AutoCAD §icheGedl

L

0@ Draw Geometric Objects
-



2.o Draw Lines and Polylines

m o draw lines

Draw->Line adowrod LINE command Boadig[Ge e@:e@:&@ogo%a@a%qo’]mu%u LINE
command o3§cbeop§: command line &> start point secacs prompt eéeedl cwoo)

L
C C e

<3len pointing device o3 click ax6qE0[g8[g6 1 coordinates cédad §odcopdatgdsd
c.?Jé:c;@oE::e\\]° start point OO'LJ wo%gc%eo:cx%eloflmoSu end point s'aogog prompt GoTcooqé
Bephicnd wodecdenigoleddi & (p. o) 0¥ LINE command sadilg: sacdessgpdch

L L

Command: LINE

Specify first point: <click 1>
Specify next point or [Undo]: <click 2>
Specify next point or [Undol: <click 3>
Specify next point or [Close/Undo]: <click 4>
Specify next point or [Close/Undo]: <click 5>
Specify next point or [Close/Undo]: <click 6>
Specify next point or [Close/Undo]: U < undo line segment 6-5 >
Specify next point or [Close/Undo]: U < undo line segment 5-4 >
Specify next point or [Close/Undo]: € < close series of line segments >
5 3
4
1
5
6
¢ (3-9)
Draw Geometric Objects 0o



>

To draw a polyline with straight segments

Draw—)Ponline o3ecpod PLINE command 3seadofS: polyline gfsefogrecyal =3

8, 8/ «Co

L O
elcﬂovmu & line § polyline S3ecodsescbon polyline o> segment ecgooo join @69@
T Select o6t segment seopsadics select [gdagoiendn line dqEeom click cwéa)
Q L L L L (] d L e L

line segment & select [g6edli eo05(: polyline o> line width o3 e@o&sozo‘éq&]mmn
6 (p. J) &3 PLINE command s>ad:[g|G: s’a?a%sqm%qor]mdin

Command: PLINE

Specify start point: <click 1>
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <click 2>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 3>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 4>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 5>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 6>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]. €

3
2 . =
| %
/ \
/ A
7/ \
f/ A
% I G
/ /
1 ‘\\ II
~ !
\\\ ‘/
i 5

To draw a wide polyline

line width eopo3 polyline ooé o%sg)aﬁéqtc: sa?cﬁsgo‘éqoqmu%u 6 (. p) Blogpdcli

®o Draw Geometric Objects
N —



Command: PLINE

Specify start point: <click 1>
Current line-width is 0.0000

Specify next point or {Arc/Halfwidth/Length/Undo/Width]: <click 2>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: W

Specify starting width <0.0000>: [ENTER]

Specify ending width <0.0000>: .2

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 3>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: W

Specify starting width <0.2000>: [ENTER]
Specify ending width <0.2000>: .4

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 4>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: W

Specify starting width <0.4000>: [ENTER]
Specify ending width <0.4000>: .2

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 5>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: W

Specify starting width <0.2000>: [ENTER]
Specify ending width <0.2000>: 0

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: €

Draw Geometric Objects o
T



To draw a line and arc combination polyline

Sondsleeom line § arc segment sogad:clo; polyline codsclon & (o- g) Blogpach

Command: RECTANG < draw a rectangle 12 x 4 >
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 4,0
Specify other corner point or [Dimensions]: 12,4

Command: PLINE _
Specify start point: 5,4 < this is point 1 >
Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: W
Specify starting width <0.0000>: 0.25

Specify ending width <0.2500>: [ENTER]

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: A
Specify endpoint of arc or
[Angle/CEnter/Dlrectlon/HaIfWIdth/Llne/Radlus/Second pt/Undo/Width]: D
Specify the tangent direction for the start point of arc:

<0Ortho on> <click above point 1 >

Specify endpoint of the arc: 6,5 < this is point 2>
Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second pt/Undo/Width]: L
Specify next point or [Arc/Close/Halfwidth/

Length/Undo/Width]: 10,5 <this is point 3>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: A
Specify endpoint of arc or
[Angle/CEnter/ClLose/Direction/Halfwidth/Line/

Radius/Second pt/Undo/Width]: 11,4 <this is point 4>
Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/Line/

Radius/Second pt/Undo/Width]: [ENTER]

e Draw Geometric Objects
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Command: PEDIT

6 (5-9)

Select polyline or [Multiple]:

Enter an option [Open/Join/Width/

Edit vertex/Fit/Spline/Decurve/Ltype gen/Undc]: W
Specify new width for all segments: 0.2

Enter an option [Open/Join/Width/Edit vertex/
Fit/Spline/Decurve/Ltype gen/Undo]:

<select rectangle>

[ENTER]

Draw Geometric Objects
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» To create a boundary polyline

8nds ggom boundary polyline még:@&ﬂoocf)u owe & (o- € o%a@o?eo.%n
Command: CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: <click 1>
Specify radius of circle or [Diameter]: <click 2>
Command:[ENTER]

CIRCLE Specify center point for circle or

[3P/2P/Ttr (tan tan radius)]: <click 3>
Specify radius of circle or [Diameter] <1.7438>: <click 4>
Command: RECTANG

Specify first corner point or [Chamfer/

Elevation/Fillet/Thickness/Width]: <click 5>

Specify other corner point or [Dimensions]: <click 6>
5
®
6 (- 6)
2
1 6

| 2 Draw-Boundary o3 choose co6[8: Boundary Creation dialog box solangé Pick
Points 0% click C\ESO']QQC)II 0 ('\). 12) or%@éor}u

Command: _boundary <choose Draw-yBoundary>

09 Draw Geometric Objects
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gttt b n ekt

{EWbundary Creation

| Advanced |

+Island detection St_‘,'hi S @ Pick Pairts
: F 7 A : E
Q

Zelect Objecls

2]

2} [0

| e e _ Femove [sands
! Mormal 4 Outer “lgnioee

.~ Dbject type

. Mil ] Retain baundaties ‘ 7

e Selectiong

et Properhies

s Boundary set - v Dipa Dide

| ]Current viewport @ &j‘! Mew

¢ lsland detection method y .Corr.;pc]siti.r.:‘u?

. ®Flood S

) Ray casting 7
Al

= [1ap tolerance

| I:::I units

Select internal point: <click point 1>
Selecting everything...

Selecting everything visible...

Analyzing the selected data...

Analyzing internal islands...

Select internal point: [ENTER]
BOUNDARY created 2 polylines

Draw Geometric Objects ob
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>

w2963 boundary polyline o3 Copy-and-Paste codeg & (p. o) eofgeonoyeedic: [gEeqeadh

\ :

¢ (5-»)

To draw a circumscribed polygon

coc c 0 ~ C 0~ <
36050070} 0MOCINOIREmNRT Polygon cosmdays)c sl Draw-y Polygon s8eun03

POLYGON command c3sacbifggEqoloncdu sosoadigannioy & (p- p) oBecpconfogpgch

Command: CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: <click 1>

Specify radius of circle or [Diameter]: : <click 2>

Command: POLYGON

Enter number of sides <4>: 6 _

Specify center of polygon or [Edge]: _cen of <hold down SHIFT key and
right-click the drawing area>

Enter an option [Inscribed in circle/

Circumscribed about circle] <I>: C

50 Draw Geometric Objects
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» To draw a polygon by specifying one edge

c ~ cocC [og s ~ cC QN € C c €
DMYDEDNGY BHICI0IMEs Coono) polygon ;osmisdgcqc Draw3Polygon ajewc:

POLYGON command c3seadlgeéedlonddi sesoadfgaonal o (p. 20) cdscpounfogpddl

Command: CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: <click 1>

Specify radius of circle or [Diameter]: <click 2>

Command: POLYGON |

Enter number of sides <4>: 5

Specify center of polygon or [Edge]: _cen of <hold down SHIFT key and
right-click the drawing area>

Enter an option [Inscribed in circle/

Circumscribed about circle] <I>: [ENTER]

Draw Geometric Objects on
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¢ (3- 00)

>.; Draw Circles

N AutoCAD «o oo%c%f: Gogo% §,é:9:ae?[:e‘j[ sgc\%elo']mmn default method ooeom omSE 36,
5 G

center—
radiu
center, radius twa points three poinis tangent, tangent,
defining dafining radius
diamater circumference
(Q. oo)
oR Draw Geometric Objects



» To draw a circle by specifying a center point
and radius or diameter

Draw-Circle §ooro5 CIRCLE command o3sz03:(g(G: 0c58€:008203 default 505:30

1

L=y Q Loy
90533610 ‘33?(\298@@0(]"

Command: CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 10,5
Specify radius of circle or [Diameter] <2.4934>: 3

» To create a circle tangent to two objects

Draw - CircleTan, Tan, Radius o3ead[g(G: object (2) 'éLaoc?’ tangent [gécs0) 0ch3c:

< o Q N Q C a Q C
2d903 mpcdadqolorddi § (5. o) Bfeapadh

Command: RECTANG

Specify first corner point or [Chamfer/

Elevation/Fillet/Thickness/Width]: <click 1>
Specify other corner point or [Dimensions]: <click 2>
Command: ROTATE

Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0

Select objects: <click rectangle>

1 found

Select objects: [ENTER]
Specify base point: <click 2>

Specify rotation angle or [Reference]: 30
Command: LINE

Specify first point: <click 3>

Specify next point or [Undo]: <click 4>

Specify next point or [Undo]: [ENTER]
Draw Geometric Objects o



Command: CIRCLE

Specify center point for circle or

[3P/2P/Ttr (tan tan radius)]: Ttr

Specify point on object for first tangent of circle: <click rectangle>
Specify point on object for second tangent of circle: <click line>
Specify radius of circle: 2.5

4
1 2 (p-20)
2
3
>.o Draw Arcs
u AutoCAD o> arc ecyo’ spissaddpgncdacioddi omeades! [qospionadeé oysod

spSecyen start point ooes endpoint s303 counter-clockwise direction s2c3&aeusgndli

arc a@@é:cﬁgécﬁ (o) (9. 0{)) cfoewTBcoo:o']mLﬁu

L L &

—endpoint of line
.
0L O
Qi ( 2 SO Specifying arcs by Three Points
o Draw Geometric Objects



3 w2
starnt(1). center(2), canter(1), stast(2),
end(3) end(3)

Specifying arcs by Start, Center, End

1 ‘
included >

angle start, center, angle canter, start, angle start, end, angle

Specifying arcs by Start, Center, Angle

start, centar, length canter, start, length

Specifying arcs by Start, Center, Length
}

Draw Geometric Objects cJ
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radius
<t =3
= iy
1 > diraction
1
atadt, and, radius start. end, direction

Specifying arcs by Start, End, Direction/Radius

% (3 29)

To draw an arc by specifying three points

Draw-Arc->3 Points 3s03:{g[G: arc cbdoadspsial o (p. 0g) gredt [gaondloned |
sogafogpdali

Command: PLINE

Specify start point: <chick 1>
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <click 2>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 3>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 4>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: [ENTER]
Command:

Command:  <choose Draw>Arc>3 Points>

Command: _arc

Specify start point of arc or [Center]: <click 4>
Specify second point of arc or [Center/End]: <click 5>
Specify end point of arc: <click 1>

ER Draw Geometric Objects



3

¢ (p-29)

» To draw an arc using Start, Cente, and End

a

Draw->Arc-Start, Center, End Points 3 choose co6[G: arc codaadsphiad o (. o9)

C C
?‘JG(DTEG)‘D.OI-IUJ(D | GC\QC\J’)@ gcﬂu

- Command: GRID <show grid points>
Specify grid spacing{X) or [ON/OFF/Snap/Aspect] <0.5000>: [ENTER]

Command: '_dsettings <choose Tools— Drafting Settings=>Snap and Grid
tab->Snap On enabled>Angle: 60>0K>
Command: PLINE

Specify start point: <click 1>
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <click 2>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 3>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <cfick 4>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: €

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: [ENTER]

Draw Geometric Objects eS
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Command: [ENTER]
PLINE

Specify start point: <click 5>
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <click 6>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 7>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 8>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: [ENTER]

Command: [ENTER]
PLINE '

Specify start point: <click 6>
Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <click 9>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 15>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 7>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: [ENTER]

Command:

Command: <choose Draw->ArcStart, Center, End>

Command: _arc

Specify start point of arc or [Center]: <click 9>
Specify second point of arc or [Center/End]: _c

Specify center point of arc: : <click 10>
Specify end point of arc or [Angle/chord Length]: <click 11>
Command: PLINE '
Specify start point: <click 11>
Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <click 12>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 13>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 14>

N Draw Geometric Objects
]



Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: [ENTER]
Command:

Command: <choose Draw-»Arc>Start, Center, End>

Command: _arc

Specify start point of arc or [Center]: <click 15>
Specify second point of arc or [Center/End]: _c

Specify center point of arc: : <click 10>

Specify end point of arc or [Angle/chord Length]: <click 14>

% (9 09)

» To draw an arc by specifying Start, End, Direction/
Radius

Draw-»Arc->Start, End, Radius o3saod:(qS: arc oocg?ag:;.ézo% 6 (. o6) eoeol[goon:

e 50)
dloac 1ecgam(ogpdch

Command: LINE
Specify first point: 6,6 <this is point 1>

Draw Geometric Objects cE
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Specify next point or [Undo]: @1<90
Specify next point or [Undo]: @8<0

Specify next point or [Close/Undo]: @1<270
Specify next point or [Close/Undo]: C

Command:

LINE Specify first point: 8,14

Specify next point or [Undo]: @4<0

Specify next point or [Undo]: @1<90
Specify next point or [Close/Undo]: @4<180
Specify next point or [Close/Undo]: €

Command:

LINE Specify first point:

Specify next point or [Undo]: @1<45
Specify next point or [Undo]:
Command:

LINE Specify first point:

Specify next point or [Undo]: @1<135
Specify next point or [Undo]:

Specify next point or [Close/Undo]:

Command; ARC
Specify start point of arc or [Center]:

Specify second point of arc or [Center/End]: E

Specify end point of arc:

<this is point 2>
<this is point 3>
<this is point 4>

[ENTER]

<this is point 5>
<this is point 6>
<this is point 7>
<this is point 8>

[ENTER]
<click 8>
<this is point 9>
[ENTER]
[ENTER]
<click 7>
<this is point 10>
<click 9>
[ENTER]

<click 2>

<click 5>

Specify center point of arc or [Angle/Direction/Radius]: R

Specify radius of arc: 12

Command: [ENTER]
ARC Specify start point of arc or [Center]: <click 6>
Specify second point of arc or [Center/End}; E
e Draw Geometric Objects



Specify end point of arc: <click 3>
Specify center point of arc or [Angle/Direction/Radius]: D

Specify tangent direction for the start point of arc: <click 11>
9 10
8 7
5 6
& (p. o)

Ik |
11

2 3

1 4

| ellipse 0628, 00mbunadel axis epmes length § width B3Bodbedbenioy dedlen
2] SN =

eoopddlonodi Bgpdo) axis o major axis o3eal G o) axis o3 minor axis cdesl closcds

¢ (- 09) Blegeddh

distance
distance
midpoint of first .
axis 6 (pe00)
major axis
endpoints of first axis minor axis
Draw Geometric Objects e®



To draw an isometric circle

Tools—>Drafting Settings o3 click oy6[G: Drafting Settings dialog box ecl'axef Snap
type & style sganabo> Isometric snapoption button o enable co6[G: OK o3 click

Q38<5|903u o (Q. on) o%@@fo’]u

e S

A ﬁfafﬁn'g Settings

'Snap ahd GW Palar Tracking ! Object Snap!

i
i

~ Polar spacing

Polar distance:

[]5nap On [F9)

r Snhap )

! Shap ¥ zpacing;

| Shap '’ spacing:

: Angle: D
A base:
Y base:

0.8000

[ Grid On [F7)
~ Grid R
Grid ¥ spacing:
Grid Y spacing:
(-Snap type & style 3
(&) Gnid snap
(O Rectangular snap
£ Isometiic snap
3 PolarShap

[ Ok L,S‘_H Cancel ]L Help ]

Command: '_dsettings
Command:
Command:
Command: _ellipse

o (o

EE

00'))

<choose Draw- Ellipse-> Axis, End>

Draw Geometric Objects



Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: I

Specify center of isocircle: <click 1>
Specify radius of isocircle or [Diameter]: <click 2>
2
% (3-0p)
Fot
L

=

» Todraw an elliptical arc using Start, and End angles

Draw—EllipseArc o3 dlick «x6: major axis sagyad endpaint (2} » « minor axis

Q
< o

sacpo> distance § Start angle 1 End angle copodoacbeddfiné & (p. Jo) enfgooniad
elliptical arc o%s@@:ogo:or]@u

Command:

Command:

Command: _ellipse

Specify axis endpoint of ellipse or [Arc/Center]: _a

Specify axis endpoint of elliptical arc or [Center]: <click 1>
Specify other endpoint of axis: <Ortho on> <click 2>
Specify distance to other axis or [Rotation]: <click 3>
Specify start angle or [Parameter]: <QOsnap on> <click 4>

Specify end angle or [Parameter/Included angle]: <Ortho off> <click 5>

Draw Geometric Objects 000
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.9 Draw Donuts

Lo C ey

Donuts s30» filled rings s3ecydb solid-filled circle coplgdessntarbecion:o; closed

2 ?
polyline ecpdlon & polyline eopen thickness §élorcSi donut ood903 create cpbeudaddged
inside diameter i outside diameter § center B3a3euqolecdn solid-filled donut 3¢

inside diameter G3oopoconcoich & (p. o) eo filled-ring sadjzecadgocy donut ooésa3

GJ@Q}’JEL;]CDOSII

T o (5 Jo)
To create a donut

solid-filled donut osé2c3 create ecpbat ARC (Center, Start, End) command ohsead(g[5s

QC (o) o C ~ C a N C o AN oco {5
arc FOCION0PND saelcmegt?leoan moogesg‘@.agj.qc Q (9. JJ) 90@000.09330’3& [e}celcfooqlu

000 Draw Geometric Objects
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Command: ARC

Specify start point of arc or [Center]: €

Specify center point of arc:

Specify start point of arc:

Specify end point of arc or [Angle/chord Length]:

Command: PEDIT

Select polyline or [Multiple]:

Object selected is not a polyline

Do you want to turn it into one? <Y>

Enter an option [Close/Join/Width/Edit vertex/
Fit/Spline/Decurve/Ltype gen/Undo]: W
Specify new width for all segments: 0.2

Enter an option [Close/Join/Width/Edit vertex/
Fit/Spline/Decurve/Ltype gen/Undo]:

Command: PLINE

Specify start point:

Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: W
Specify starting width <0.0000>: 0.2

Specify ending width <0.2000>:

Specify next point or [Arc/Halfwidth/Length/Undo/Width]:

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:

Command: [ENTER]
PLINE

Draw Geometric Objects 00 |
I

<click 1>
<click 2>
<click 3>

<select arc>

[ENTER]

[ENTER]

<click 4>

[ENTER]

<click 5>
<click 6>
<click 7>
<click 8>
[ENTER]



Specify start point; <click 9>
Current line-width is 0.2000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <click 10>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: [ENTER]

Command: DONUT

Specify inside diameter of donut <2.0000>: 1.5
Specify outside diameter of donut <3.0000>: 2.5

(- JJ)

.6 Draw Reference Points

| 4

To create a point object

point oxdac? create cobedd=dqé Draw-3Point-3Single Point o choose cobff 0cH3t:c3G

object sadmesnedlen click eo:qé point ()%Béqgneo?o%(ﬂoesu default sees4 point
size o appofgbegaidlon

009 Draw Geometric Objects
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Command: CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: <click 1>

Specify radius of circle or [Diameter]: <click 2>

Command:

Command:  <choose Draw-Point->Single Point>

Command: _point

Current point modes: PDMODE=0 PDSIZE=0.0000

Specify a point: _nea to <while holding down SHIFT key, right-click on
drawing area. Choose Nearest from shortcut menu,
and click 3. But the point is not visible to you>

» To set point style and size

point 3gEaEq€ Point Style dialog box et(E: paint size AGEsuigolecti Format-Point
Style c*roL) choose cxef)o']u G']ST?)G[(% Point Style dialog box GOTCD’)O{]@II o (o- J?) o%@éof]u
Paint Size o3 10% cox(G: OK o3 click cpbeé eansenmegpadeso point

LD’)GOTCD’)L;]C\%%@CBII

ri’E[ Peint Style '

Hile;
O

~
]

EHEHE

[7
L

o (3 Jo)
Print Size; 10 ] %

{¥) Set Size Relative to Screen
{ Set Size In Absolute Units

[ DK%'J[ Cancel ]E Help ]

Draw Geometric Objects 200G
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>.n Draw Construction Lines

>

To create a construction line by specifying two points

20orechonicd mapch (2) acdgobogmoy construction line o;daciadgeé Draw-Con-
C

N ' o] o ~ Q o o Q 2
struction Line o3 choose «x6[G: gaeeagsgcxaqcﬂmwu 5 (o ) o?@@u’]u

Command:

Command: <choose Draw > Construction Line>

Command: _xline Specify a point or [Hor/Ver/Ang/Bisect/Offset]: 0,0
Specify through point: 5,5

Specify through point: [ENTER]

command:

A 9 (- U5)

To create a ray

iy

200He0Han0) Nedmbsmmel§ sdwmecddgobognay construction line ;oo

L,qcﬂooo.)n (_LJ (g, Jg) O%L@écﬂrr

o
[ o Q C Q =
waeqe DrawyRay oy choose -:\L)o@: 5990050

Command:
Command: <choose Draw>Ray>

209) Draw Geometric Objects
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Command: _ray

Specify start point: 0,0

Specify through point: 5,5

Specify through point: {ENTER]

% (- u9)

i

Create and Combine Areas

To define regions

cC o _C

point ;®2a3 create cobecd=BqE Draw->Point->Single Point o3 choose codff: 0053836
object s2q sagmedlen click geo:qé point BlgSaerewcislo default s:esé point
size m ogez@f)eﬂ\cé_cﬂbn

Command:

Command:  <draw a polygon>
Command: _polygon

Enter number of sides <4>: 6

Specify center of polygon or [Edge]: <click 1>

Enter an option [Inscribed in circle/Circumscribed

about circle] <I>: [ENTER]
Draw Geometric Objects _ 206



Specify radius of circle:
Command:

Command:

Command: _rectang

Specify first corner point or [Chamfer/Elevation/

Fillet/ Thickness/Width]:

Specify other corner point or [Dimensions]:

Command:
Command:
Command: _circle

Specify center point for circle or

[3P/2P/Ttr (tan tan radius)]:

Specify radius of circle or [Diameter]:

Command:
Command:
Command: _region
Select objects:

1 found

Select objects:

1 found, 2 total
Select objects:

1 found, 3 total
Select objects:

3 loops extracted.
3 Regions created.

Command: BHATCH

<click 2>

<draw a rectangle>
<click 3>

<click 4>

<draw a circle>
<click 5>

<click 6>

<cCreate regions>
<select polygon>
<select rectangIeS
<select circle>

[ENTER]

Boundary Hatch and Fill dialog box eol'ewoqé Pick Points button o3 click coddleadn &

(p- J&) oglogpach

Draw Geometric Objects
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Pﬁundar*} Hatch and Fill @
Hatch Advanced” Gradiert
Type: {.Predeﬁned

Pattern: | ANSIA1 F-

Pick Paints

Select Objects

Swatch:

Famoee | sands

Custam patterrs:
Ange: [0
Scale: i‘l.GGEIG 15‘

Wiewe Belections

N 2 X B 5

Inherit Properties

[ Relat o Drave Ordes e
elative to paper space : — .
PP i Send behind boundary fv I
Spaging: |1.0000 I * oo
5ot (NN ~| | i |

(O Nonassociative

& (6 UB)

Select internal point: <click 7>

Selecting everything...

Selecting everything visible...

Analyzing the selected data...

Analyzing internal islands...

Select internal point: <click 8>

Analyzing internal islands...

Select internal point: [ENTER]
Draw Geometric Objects 000



Boundary Hatch and Fill dialog box [G8edTaneé OK o3 dlick codclecSn sl8q€ &
(p- o) erlgoonoymecié: selected region eagen hatch fill [gdogo:dlg

To define regions by using boundaries

region copcd Draw->Boundary command 3e2ob[gG: socdecdeoqdlonddi saedlen
o E[g3odspds, aveamsacyonoldu Boundary Creation dialog o3s2a3:(g[G: select cobgop

closed area oégo click aJcao:e}o'!euSu

To combine regions by adding

6 (p- o) eolgeonio) object (3) ?o%ag : region eoplybeaané create cobeodh @:soaqqcct

(=]

Modify->Solids Editing->Union command c3ea3:(gfd: region sopa edlésoicdqdloncb
¢ (o Jg) FHlegech

Command:
Command:  <choose Modify- Solids Editing—> Union>
Command: _union

o0@ Draw Geometric Objects
: -



¢ (3- o)
Select objects: <select polygon>
1 found
Select objects: <select rectangle>
1 found, 2 total
Select objects: <select circle>
1 found, 3 total
Select objects: [ENTER]

¢ (5~ Je)
Draw Geometric Objects 000



To combine regions by subtracting

3 (p. ) eolgeonio; object (3) aa)(G: region scplydesent create awbeordh [Greomgt
Modify-»Solids Editing->Subtract nion command o3=e23:{g[G: rectangle region mes

oy§0) region GOgCPEiO%GU:O{]Q(JSu & (p+ 20) o3yl

Command:

Command:  <choose Modify—> Saolids Editing— Subtract>
Command: _subtract

Select solids and regions to subtract from ..

Select objects: <select rectangle>
1 found
Select objects: [ENTER]
Select solids and regions to subtract ..
Select objects: _ <select polygon>
1 found
Select objects: <select circle>
1 found, 2 total
Select objects: [ENTER]
¢ (¢~ 90)

To combine regions by finding intersections

o (p. o) golgooma object (3) ?o%ag@: region eopfgbesnt create cobeo:dh [Greomqd

s}

rectangle § circle region eoyo? union seetcodecsls qoono) region o3 polygon area
§ interset Q@@écﬂeu‘ﬂu o (:\3, po) o%@éor]u

5900 Draw Geometric Objects
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Command:
Command: <choose Modify->Solids Editing->Union>
Command: _union

Select objects: <select rectangle>
1 found
Select objects: <select circle>
1 found, 2 total
Select objects: [ENTER]
Command:
Command: <choose Modify-Solids Editing-yIntersect>
Command: _intersect
Select objects: <select newly created region>
1 found _
Select objects: <select polygon>
1 found, 2 total
Select objects: [ENTER]
¢ (p- 90)

i

o.¢ Draw Multilines

» To draw a multiline

Multilines a3 draw cobgEqc Command line g> MLSTYLE 38c800a86h & (p. o)) @
Booo:of)sao%&: Muitiline Styles dialog box eo’T\an(ﬂ@u default multiline styles (Jgoqé:@lé

C o g C < ~ < Q C Q C L © L
(2) eop&adeneach Sgfelopecyy, spacing BwmoScdoodbecdadadgs zero offset

Draw Geometric Objects 09 |
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Qg oeedlen +0.5 03 esaacben -0.5 wsé spacing ecgoomieus Glooddi posdlé: 1
w55§cmec) 93803 multiline sedfseono’ Standard Muttiline Style c3eslGlosddi com&fg

Element Properties button o3 dlick cx6clu

[ Multitine Styles Y]
[» Multiin Style : B
| Curtent: | STANDARD v]
iName [STANDARD |
; Descripticn: | I
| rLDad | | Save.. || add | [ Rename |

5 (e-2.)

TR et

’ Element Properties ...

[ Multikne Properties ...

[T [ ] [ ek ]

o (o= 99) gﬁ@ooo:of)gao%gz Element Properties dialog box cdl'coodgn multiline gd:eopd,
medl g b Top offset element | eseadanetic’ Bottom offset element deslomedu
wacs Offset element gficoydadqéeé Add button & click cpdgolecds

ooc%mcﬁcfé zero offset element qje qﬂeaeo'?eo +0.5 %§5qi§:m56@95: i +2.0 Q‘ﬁ»u%

qézm%@@oé: [ emo%o:cﬁcin -0.5 o£§oq|e.m03@08:§ -1.0 uﬁ,éeﬂézmée@o& ?Qs(ﬂ&:
oz (4) G@’JE“O%SC\)QQ%SSJ]BH Add button o3 (2) @59993@@ Offset box ¢ 2 ¢ -1
09303 9 oogor]u 0.0 m%oeﬂe R eleles oyeox delete cooo’]eoou [§ 610 OK &3 click mocﬂn

& (p- o) FBlogeadli
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Element Properties

Elements:  Offset  Color Liype

0.8 BYLAYER Bylaper
05 BYLAYER BylLayer

[Add | [ Delete ] Offset

(o [ FEE

I Ok ] rCancel ] LHeIp ]

6 (p- 99)

Element Properties ‘ @
Elements: Difset  Color Livpe
2.0 BYLAYER ByLayer -~
05 BYLAYER Bylaver i
0.5 BvLATER Bylaysr W

[ Add | | Delete | Offset 5 (o 00)
n L
BylLaper

Ok, | Cancel | [ Hep |

> 93339%615 Multiline Styles dialog box o%@f%c;epcﬁm@: cOOETIM 031%@0350% select C\Egéo}

L

multiline (4) sfogoé:ad & (. p9) wojgeoroysecits [gEaealgbolonadi eoxE(d 1 Multiline

4

Properties button o3 click codfo3pbqes»éi omlgdocd

| 2 Multiline Properties dialog box eclandledgechn & (p. 06) T3lagpsch Display joints
box ¢» check ogf)or]eosu esnonG: Caps cemabon Line Start § End box eogg)cué:
check & apbolBsochn Greomgé OK o8 click cp&dlu

Draw Geometlric Objects 090G
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M'ulti —_—

Mulhline Styla - = - -

EEurrentt ISTFJ\NDAHD EI
Name: [STANDARD it
éDescription: | 1 |
’ { Load... ] [ Save... ] { Adcﬂ [ Renare ] '
¢ (o 29)
Element Properties ...
’ Multiing Properties ... P J
Wy
L 0K ] [ Cancel ] [ Help ]
Multitine Properties RN |
Display joints
: Caps - -~ —
% Start End
Line
Outer arc ] | i
Inner arcs 1 ] ([) (90 ;\3@)
Angle 90.000 | [a0.000 i
o r Tmae—
; [on
oK. E! | Cancel | [ Hep |
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sls3q€ Multiline Styles dialog box c3[g&espodarneadh censonm gf: (4) slopéicdben
(90) go?} 9&@:@@063 (2) cloption Bo%eﬁ;moo%soaslorkgéaecﬁu a3l (90) 80% Line cap
s0e0ll macocdmgfiecdd} joint cdes! Glosubi og§eondSaispohyibio? 56300083
joint ;620 saf§edTaooendli eoméi(§ 1 w22 select cxboonioy multifine style Bgoopben:
gulecSn Name: box ¢> BOX o3§ndcopifd: Add button o3 click cpdaln Current: box ¢

BOX oxciedl aonoladgedh Save button o click cobclacdn & (p- p0) SBo3pddl

|
e

Multitine W
~ Multiline Style
Current; IST;&NDAHD E’
Name: |BE|>< |
" Degeription: | |

Lo, ) | oy, ] [ ol ] | Hipere }

[ Element Properties ... ]

[ i Properiss... ]

[ 0K ] [ Cancel ] [ _Helpj

o (- 99)

> Save Multiline Styles dialog box sdTaooc|§i File name: box ¢o BOX c§§cbeopdfEe

Q i C g a C C
Save 0] click cmeod]eo.)u 0 (Q, Qm) og@egor]u

~ C C

| 4 G(m&@ ( BOX style 0%99:1’2:@[@: multiline sopadlogppgsscl
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i&l Save Multiline Style ﬁ ﬁ

Savein: | {3 Supparl ] i ax 1H Views v Toos

S } MName = Size Type Date Modlﬂed
L\sé i ey Color ' Fil Foldet 5/26(2004 9:19 A
Histary \ OiHelp o File Faler 9/26/2004 9:23
. I | DProfiles ! i File Folder 9j26/2004 9:24 A
"j L DRegisteredTools File Falder 9j26{2004 9:24 4
) ToolPalette File Folder 10/2{2004 12133

My Documents | [ acad LKB  AUFOCAD Multiine D...  11/30{1995 3147

X

Favarites

B: N

Deskiop ) B B IR
o . - o
¥ o BT = dEe g
Buzzsaw : Files of type: F-;h'l I_"j
$ (- 99)

Command; MLINE

Current settings: Justification = Top, Scale = 1.00, Style = STANDARD
Specify start point or [Justification/Scale/STyle]: ST

Enter mline style name or [?]: BOX

Current settings: Justification = Top, Scale = 1.00, Style = BOX

Specify start point or [Justification/Scale/STyle]: <click 1>
Specify next point: <click 2>
Specify next point or [Undo]: <click 3>
Specify next point or [Close/Undo]: <click 4>
Specify next point or [Close/Undo]: <click 5>

Specify next point or [Close/Undo]: €

209 Draw Geometric Objects
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6 (o- cg)

» To edit a multiline

O (- pp) o0 vertex saodd (2) esepad edit udjpigdqeseoti
Command: MLEDIT

Multiline edit coSecSc3 2850070l & (p. Go) eofgaoncysedidé: Multiline Edit Tools
dialog box sdlconoyseslmies Delete Vertex box o3 select cwofG: OK o3 click cpdch

Multitine Edit Tools 'ﬁ\
L == || l”
= Lol L] il
== 57 Pl i
U .

_N_ -_ll HI 9 (9" 90)
==l
= o Wl el

| DK[ | [ Cancst | [ Hep )
Delets Vertex
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Select mline:  <click 2>
Select mline or [Undo]: [ENTER]
slded & (p. 6o) g:@m:c}mo%é: vertex (2) esr.epd%qlo%oo%cgl_cgor]@u

I:ZI2 3

o (o g0)

5

> 80631 6 (. go) edl'en multiline (6-7) olyo>a3{Gicom object (2) sfgodognio} esepecpyn
edit cobfogpdqesmén O (p. g J) Slogpddh

o (- 9)

00 | Draw Georﬁetric Objects
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»  command line ¢> MLEDIT 3 §cbcopifG: Multiline Edit Tools dialog box edlconoysaslen
Open Tree box o3 select cpéG: OK &3 dlick cpdclecdi & (p. o) Brgpsch

[ Multitine Edit Tools B
= E LT
= [ I
= B2 el el

oK [ Cancsl | [ Hep |

Open Tee

¢ (e- 59)

> eué:s@oé: (6-7) 3 (1-5) 003 click C\g&ﬂu @:qg ENTER (L)O'Sf.;.]ll sr]ac:i)elé o (9. c;(;) eolgoon
Poecdt: multiline edit cp6Btoxo:d]G

6 (5 59)
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2.00 Create Unbounded Hatches

<

8csepen G§0059@:mc[§q|5mm8%m HATCH command c3aeaX[g[8: user 8o3[5od
click gjeuzoyesepecgen  hatch boundary fill codacdaobenioyspadlon eq8&meagiecgen
BHATCH command cdsaad(gaucloncdi & (p. %) enedl[gaome) drawing object ¢,
somadgo unbounded hatch o503 Earth pattern 3 fill cpSlogpbgesatn

& (p- 99)
Command: HATCH Unbounded hatch fill cobecdad efmgn
O’)’)O(]II
Enter a pattern name or [?/Solid/
User defined] <GRAVEL>: EARTH Earth pattern c3ssad{golecSi

Specify a scale for the pattern <1.0000>: 2
Specify an angle for the pattern <0>: 25

Select objects to define hatch boundary or <direct hatch>,
Setect objects: [ENTER]

o Jo Draw Geometric Objects
.



Retain polyline boundary? [Yes/No] <N>: [ENTER]

Specify start point: END
of <click 1>
Specify next point or [Arc/Length/
Undo]: INT
of <click 2>
®ed (3) esepoes s000d (1) sseplgh

Specify next point or [Arc/Closef
cepadayemcd cmbocdaopd click affieon

Length/Undeo]: €
close @.%C\EE)O‘]QLBH

[ENTER] sldqé unbounded Earth
pattern fill 0:38@::13’3;0’]@ ¢ (Q. 9@) (“Pg

B

Specify start point for new boundary

or <apply hatch>:

A\
5
“
(N
- A P55\ ’;\
| AN
A e S e
PN e e
e
\X;{,\Q\/&{\:\gg\\,ﬁ\,
TTAMAN
3 (¢- 96)
°JJ
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CHAPTER 4

AutoCAD®

CHANGE
EXISTING
OBJECTS

AutoCAD 3053003 weomedlosfadeé drawing command copaBaiapyd
modifying method seacdBeophs Baséclosci object modify o 5 (2) sp3 w&3qalonedi

command mégo%mq&oeo:@@ modify ng)t%sraogcf) object epa select C\E(S | modify oeﬁecoozll
dloeoncd object copBeeqé select cobffieonae modify cxdecomn ocdcBogdlyd Ssp3: (2) gt
D0 madfgedqulonddi object szcd double-click cobecdsde3§qE Properties window s5ecodd

L 24

dialog box odasdlanesdli 238mes object property sopaocbechenicdqulonddi eestoiiomm
object Gogngg modify aagaacc: object selection @ézeogo%ogm:%?)@&ﬂmu%u

N Change Existing Objects
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GO Select Obiects

» To use the Window selection method

object selection spS:eogorsagpifoiclon PICKDRAG s3c) system variable c3aspocon:
cuqé window selection area §,60¢ (2) esepwn click obg0dBsjevionnd object e
select [gdogo:cIgn codmebed PICKDRAG = 1 cdeonseoiqt pickbox ddssecbonbaoes
sBwomemeyepsd drag 533G mouse button Scomomo? release cody object select
[§6ench ocoestiontlggéor selection method o object ecpo’ selection window &G
select coda3spdali & (g o) ereal[goontayden object oég)3 select cpdfogpsqené

L

PICKDRAG = 0 doon:cleddn denfaaomapsncdts meds (1)1 2005 (2) esepecgen click

. o c o _C 2 ~ c c C c [agle}
QJ@: selection cpoecssdge rectangular selection area cden cyoeEdRO03I0Y cEPOIY

503 object coyadd select cpdenoli saacd left-to-right select 55000505103 Window

L L

selection method Se3lCloncs & ((;. o) m@cc:e@qoﬁsoazscméswo%emm select @5
L L i " a

4 s}

ogoioy node point ecyolon pickbox o> selection object ecpaad(esecdsbec CTRL

L

§60001(8: object sapcBonboopdd select opmedqilonddn select apoiqé ESC key o386dl

1
i
B
o I - a-n ‘-: ______________ H
. ﬁ Eﬁgﬂ """ 5 H
' t
/ 2
¢ (g+ )
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To use Crossing selection method

Ddmdcdup: coreerc§imat3c) selection cpdspsicl Left-to-right sses: Right-to-

left click geuzecdadaé selection area wenespodesa) object syeslgé selection area
o €ross cobayoy object ecpo3dl select codendh s3803 right-to-left selection sadjs
smondd Crossing selection c§eslGloodbn & (5. J) eo Crossing selection 8conc) node

L

point eogo%ctﬂ@ooosaﬂmo& 6 (g. 9) $8E:decromfogpidh

AL

of e Ly B =3 -hﬂ‘ 1
@] & m
E B __________________ S T 'B
R A E 8 2t 3 ﬂﬁg‘ e
o} B ﬁ g S 5H )|
y o 7

2 E‘ _Fﬁ'
% : ' o (s- 0
A G& Ba
% &
o1

To use the Window Polygon selection method

Crossing selection e§pobmbdm doagpbeayo) selection area gjsecya? create cxbaéet
mad{godspifgbolondn 8spien Window Polygon § Crossing Polygon selection s3cyspS:
(2) $5:8Clonedn vooespilgdey Window Polygon method o3 & (g. o) anmcﬁscoaﬂc?ﬁ@
coxolescdy Status bar edloo SNAP | GRID : ORTHO | POLAR 1 OSNAP § OTRACK
mode sogo% OFF C\EE)CO'):(.;]II Breorngé Command line > SELECT c3§chenpddlocdi

Command: SELECT object select cpdecdh

o J9) Change Existing Objects
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Select objects: WP

Window Polygon §é:o%szo.'3:@o’]eugu

/2\

e

<

First polygon point:

Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:

Specify endpoint of line or [Undo]:
16 found

Change Existing Objects o |6
[ ——

SN
>

<click 1>

<click 2>

<click 3>

<click 4>

[ENTER] slsbe & (g- 9) oolgeonrad
%3¢ Window polygon selectio otes

mo%sognq(ﬂcgéeosu object (16) »

select @66@0103(.1%



To use the Crossing Polygon selection method

Crossing polygon methed osscopS: Window polygon sps:gaseomsacpapdlon object
select co&fFagoret Command prompt ¢ CP(Crossing Polygon) 3§cbcopddh Greomaé
5 (g. g) wlgoonoiddmecic: dlick gpgnch slbgE polygen selection area Dea00éa)
object eqporéecmnd Cross cbayxoy object eqyadol select wb[GrogorolG

///2\\\

< . >

To use the Selection Fence method

< b = [of () = b (o oy < . :
goecgioy AutoCAD drawing ombawoolota; object copedm (gmsmpr{gm@m object
Q

a8

conm select 036:3]803(59%515 Selection Fence method o%s’aa‘:):@lqd]eofm Fence e‘cz)mo

oL
og$eondoy select v6giécy object még| 03 [godaymadeirondelamédlon ¢ (g. 9) @
Fence ga:fg:@ﬁé:o% e(mgm'):o"lmcﬁ | ecgcuo@é(ﬂu

Command: SELECT ot * eopdd select cwddleddi

DR Change Existing Objects
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Select objects: F

First fence point:

Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:

Specify endpoint of line or [Undo}:

8 found

FENCE command o%eo:oaoo’]u

99908 (1) eseponss

mecd (4) esepad click C\Eaag):o']u

QL O C = .
ENTER 8§60l slDg & (5. 9) enfgaon:
~ oc ¢ c w . &
oai&ydieloptieny isocircle eoo’

select cxgﬁ@:og::or]@u
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s.; Remove Objects from
a Selection Set

u oi$ear5a3 object selection set cxoacderéfeo selection oden edloteoqiéc) object

L L 4

=

copa remove codgat apdadquars 1 goloacdi poen & (6. B)oo object egyemmiadiad

E
Select All c6ff: odg)e3 remove [g§adevfmpdeeenéi

=

Command: ERASE object eozeiodedba command seson

oh € cxcé 03§D coéq&meg.qcﬂmwu

L

Select objects: ALL o (6. 6) oo object ey 92§ gobeddal

7 found 333%%60" Sododh object (7) 203
select codaBas0]g

e Change Existing Objects
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Select objects: REMOVE select cobff:con: object eopmes oot
2 om

eqogemqquc{t)_ remove @%co 5:

Remove objects: 6 (g. 6) oo hatch fill area o3 select

1 found, 1 removed, 6 total pGcledd

Remove objects: ENTER §60hi s13q€ & (g. €) oo hatch
Hatch boundary associativity removed.  fill ;620 remove ecoddg§eon(G: Hatch

boundary o>6acb:c3 quogoécx%a%@@&ﬂ
C a Q C
035 § (g- 9) FHlogeadl

7 ///////

/

/////////

» To use the Quick Select

A nnmmmn

NN\

\\\
\\\\\\\\\\\\\\\\

29mdslmélggomna Quick Select codspd:cli drawing object sagpifcdomes d3ebcd

L

qiéc) selection set odod? filter cxbgcet Command line ¢o QSELECT o3§obcopiff:

Quick Select window soTco'qu’aar]cjn Properties box mes filter criteria mdscd choose

L L

Change Existing Objects 000
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cobegleddn comé:fg 1 drawing 8€odacd load coboli Command line ¢ QSELECT §od

coppfe Quick Select dialog box eolaoncdssioygé Apply to box o> Entire drawing s
Object type: Multiple 1 Properties: Color = Red o3 choose &8s OK o3 dlick ap6al
0odn & (G. o) Blogpadh How to apply eszoien Inciude in New Selection Set option

Salat) é: select mBmzqé]eoSn
L L

i Quick Select

Apply to: lEntire drawing .li .Eﬁj

Object type: 1 Multiple :]

Properties:  {Color
Hyperlink
Layer
Linetype
Linetype scale
Lineweight
Plot style

Operator. ] = Fquals

Yalue: 10 Green

How to appls M Eulayer ‘{A
% [nelude ihne ..By Black
7 Exclude from 0] Yellow bg -

[~ Append to current selection set

ok | Cancel | Help

slBqt © (g. @) eolgoontayendits m8eeplyfiecgs ool object sopeaiadiad AutoCAT

o> select cobew:adadslfi promodfaéien mscdeplydreasadoonc; object eoyadeo:
AutoCAD o Qﬁoo'}:é(ﬂoocﬁu

090 Change Existing Object:
I



h = P T
-
Pl
NS
) [
O
d [
2
¥
- i
»
K, .
]
¥
+
Tamn®

i

3
-
e m

-9
pacS
2
)
¥
¥
%
-
R
'
¥
v
F
r 3
&
[ ]
¥ ]
“Fu
[
i

-,
‘b
\-
-
‘V

LTS
-

N,

¥

]
[
=}
.

o -
-
‘Q

*,

o (5-¢)

=
¥
r
I
L]
4
I;
]
¥
¥
.

- R

» To use the FILTER command

g9003] FILTER command oBseod(g[G: ¢ (5. ) 9 msodeepleirecysaioona)
object 6080% select cod[golecdi Command line ¢o FILTER o%%ogooéo i Object
Selection Filters dialog box ecleondIi ¢ (g 00) O%Eééln Select Filter comodm
Color o3 choose C\E(S(ﬂ@(ﬁir sgo0nf3: Select button a3§6¢ln

> Select Color dialog box edlaondf Full Color Palette comdcbmsagadeqpt scotecontaad
condd  click cpbocSaBeg Color: box ¢ 50105 (18) edleguleddecdi s3slsagadeepts),

color number dli eom&f 1 OK o3 click w&0lecdi

P Black color &3 select coS:q¢ Add to List button o3 click cpbli List box cdgn color =
18 cdedlaxncladdech filter name o3 Colorfilter c3§cbaopd(d: Save As>Apply o click
@6ogenddeé Command line oo ALL Bcdcopdomy sastdeeplefienydzdono)

o
o <

object 9039301)%0:3:(}33 AutoCAD o select C\gf)eozc?m@eco 1O (C,. oo) U%@éo']u

Change Existing Objects 29 |
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‘Object Selection Filters G—_——

- Select Filter

| | Edtltem | Delete Clear List |
C - Select... I ; ;
olot — —-% | Named Filters -
Block Position P |
| |Block Rotation - Current: p
' {Cicke = . l unnamed ﬂ
i :l L Savehs 1 | |
| ] '
. o Delete Current Filter List i .
¢ | Dimension Style Substitute l { I e

i
Add Selected Object <

Elevation

Apply l

|

Cancel

{pe——

Stemdard Colors ————————-

L

Gray Shades

[

Byl ayer

¢ Full Color Palette

DK

Cancel

Help

a9y

Change Existing Objects
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;E!ﬂ?,‘?,t Selection Filters h

Calor = T8

o R

i-Select Fier ==z ; Edit |tem l ~ Delete J Clear List l
Select.. l .
iCoIDr -:j = | - Named Filters e

E?i: =~ |18 | Current: l"uﬂnamed .1]5

k2 f —d I | Save As: ! | [
2 = = [ | Delete Current Filter List J

rRddte s substue L _mmmmm————eeemee———— |

Add Selected Object < 5 £pply § Cancel | Help !

& (g- 09)
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.o Move and Stretch the Objects

» To use the MOVE command

object eogé]nsagosgam:% S PRt Tos I RteTR N e§qaegoeozq8el5 MOVE command
o%sga'g:@lc%qo']mcﬁu pow O (9, 5 J) ?oewmm:of) selection ooo%?o% DS move
(54

C\go@éq GS’B’J(C:II

= CH3M -«

¢ (g-0J)
Command: MOVE Move object cobdleddi
Select objects: object selection codali object (4) 2
Specify opposite corner: o3 select [g6orcSadelmgrclond
4 found
Select objects: [ENTER]
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Specify base point or displacement: <click 1>

Specify second point of displacement or  ;boabg&il g gEaimmngaco:

<use first point as displacement>: mds move cdeusdh seedd (2) esep

click qqﬁqor]cr)cﬁu 9']35:6.18 o (g. og) e
[Gooioyeecdé: Move object codBci

1

¢ {5 09)

» To use the STRETCH command

Command: U
MOVE

Command: STRETCH

Change Existing Objects
I —

UNDO E}@C\gﬁoﬁu LL) (g. OJ) mefao%f::
B5{g5og2:cIGr MOVE scpbatonddecl

Q

Move object codgé: object o3
stretch q&@écﬂecﬁu

o6



Select objects to stretch by crossing-window or crossing-polygon...

Select objects:

Specify opposite corner:
8 found

Select objects:

Specify base point or displacement:

Specify second point of displacement
or <use first point as displacement>;

crossing-window selection codol
o sefect [goorcbede(mlgrolonddi
rectangle ecpq, oaﬁoseogo%or] select

coécgﬁooo:ooo@o%d]maﬁu
[ENTER]
<click 1>

<click 2>

9 ¢ = N B,
slBqf ¢ (- 26) grlgeoncyedits
stretch [gdogaicoecgmedsledicdese

C o "] oC <
8@00:38’320‘)‘30? €0, §olc0ge I

& (5- 29)

ove
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GG Rotate the Objects

» To use the ROTATE command

80063l § (5. 09) o> dotted line $eal[geono) selected object o rotate axbogpbgesati
Command line ¢> ROTATE command o}§osaopdolec

Command: ROTATE Rotate object cpodlecsi

Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0

Select objects: object selection coboli object (5) 5
Specify opposite corner: o select [gdonodadsfmgacloncs
5 found

Change Existing Objects Do
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Select objects: [ENTER]
Specify base point: <click 1>

Specify rotation angle or [Reference]: <click 2>
slBqé & (g. oB) enfgeomaysacies

object rotate [gbogoiomadecy gileddi

.9 Align the Objects

» To use the ALIGN command

ALIGN command o3 3D editing command saes§oocheciconeoodd 2D escph: saad(g)
Jqolodchn ALIGN command o3seal(gigiéonchadec Modify—3D Operation—>Align

3 select cobdli sleeuscd Command line oo ALIGN o3 §obcopdeaopbigsloads Align
command o» oadesudeor; MOVE 1 ROTATE § SCALE command (3) sadeedlCseon:

omdlon ALIGN $¢5306006003 aaga(ogpadh

Rlelc Change Existing Objects
L



object selectad with source and destination result with the scale
window sefection points oplion used

> & (g. 09) > ALIGN command o3sa3(gfé: object (2) :%oc::asoogeozocr):o']mugu

e
==
M”;"“:: -
e i
— .
e ¢ (g-°2)
"
1 4
3
Command:  ALIGN object (2) 505 Align-and-Scale
cwboleddn
Select objects: & (G. 00) mseed] oo object of selec
Specify opposite corner: w&aled
Change Existing Objects 0Go



2 found

Select objects: [ENTER]

Specify first source point: <click 1>

Specify first destination point: <dlick 3>

Specify second source point: <click 2>

Specify second destination point: <click 4>

Specify third source point

or <continue>: [ENTER]

Scale objects based on alignment sldeg saedl' oS object umesmdio
points? [Yes/No] <N>: Y bject megzc%o%@ogesméocé s'agcf)sam:

GODSO.ODOS(.;]@II Ll) (qu Oﬂ) CT%GC\QCD’D@&T(;]II

"‘-x

N
. x\ -~“-:\
:\C\ e Y k

///

;"

%

,ff

Offset the Objects

To use the OFFSET command

mamdalecycongoay OFFSET command oli OFFSET command wosdeé selected
object mocaaems.?vsmgggmmog?o% sco object %93@[5 a)o%?cgooo:o}s'aogasasosmn%ag |
200500500 O’Jéesr.spoo(ﬁm create mﬁeozgéﬂmogu sloowdd e58undd aahecd
J B 4 L d L Q L 4
~0C

onc)mecimdafyches esantaopd: BICs glonadi #3103 Offset cgﬁo)ogocéeﬁror]mosu

0Go Change Existing Objects
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offset qpocBeod object soyaden line arc circle 1 2D polyline 1 ellipse 1 rays 1 spline

%o%wécﬁaﬂoé@&mtﬁu offset QEE)QJ(C:Glé Command line e OFFSET or% enter C\E(S(ﬂ\
sleooncd Modify menu mes Offset o3 choose cobetophiqdlondhi & (g. op) &

~3o

4
polyline object méscBarmmaben offset ecysagniFardly comdlondSi meecdmba

[gdGeomaopd: offset cxblgaomdloncd 1 sapeonfogabol

(S

¢ (5- o)
Command: COPY % (g- 0p) §, oodocdagsmO
copy op&cleddi
Select objects: madmadeegsen polyline o3 click
1 found 8ol somEegepen click goli PLINE

command § sdoonsoysrcgad object

< ¢ e 1
[opls} ?O’)go @oc@m}o i

Change Existing Objects oG |
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Select objects:

Specify base point or displacement,
or [Multipie]: <Snap on>

Specify second point of displacement
or <use first point as displacement>:

Command: OFFSET

Specify offset distance or
[Through] <1.0000>:
Specify second point:

Select object to offset or <exit>:

Specify point on side to offset:

Select object to offset or <exit>:
Command: L

LINE

Specify first point:

Specify next point or [Undo]:
Specify next point or [Undo]:
Command: OFFSET

0GR

[ENTER]

<click 1>
<click 2>
slsdqt object copy mésom

@’J.’.DO%O% GGP(TC_)C\)’)O’]@II

pnmadon object of offset codfognd
qesEl

<click 2>

<click 3>

offset distance (2-3) cdonudesepend

click geoscos elcﬂc)oSu

offset cboch object o3 select cwdal

< o * Q H C
scdi mecb (2) polyline o3 click cxdaln

object 3 pyocd[géien offset codeous
géodmadd polylinedpnmoimbesep
@ click 0;350'}" :ﬂa@q& offset object
0 2603 (3) eef.epepcorrm(ﬂ@u

[ENTER]

<click 5>
<click 6>
[ENTER]
pmobeagson object of offset coddl

Change Existing Objects
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Specify offset distance or gprefopés (5-6) sclorsrecdondacy

[Through] <0.5000>: T ohogrioy offset BE:onbacd create
C\)OU"]QOJII

Select object to offset or <exit>: <click 3>

Specify through point: <Osnap on> OSNAP mode o3 ON a6F: %0605 (5)

esep endpoint o3 click codal s']a%slé
2005 (5) dgodayxcy offset linecods
L o - L

eon@@oSo’]moSu ‘3 (9. oe) (ﬁ@é(ﬂu

c 2 o C _oC C = < Q
GQB’JO’JG(ETEU'](L)O'} OD(.DCOQDO?OOO?C CD(TDGOC?DC\EO@@J'B»II

ﬂ O

offset automatic trim

.o Mirror the Objects

» o use the MIRROR command

5 (5. Jo) eolgaomioizacié: D encd: em&mém%@&:tﬁe@@:mzm&a&i&%u object &
command line ooes MIRROR command c3§cdcopiGe eadByaiondegesnt cwdade!
oSlesmcimnadm D obgéod mirroring cxo: D esclfgdesmnéardfogpich mirroring
wi[Geodmeslen oo object Beopiigoonteotecdsdql D encdioiqGech

L L

Command: MIRROR Mirror object cobecddli
Select objects: S (g. Jo) o D ockond(gia) select
Specify opposite corner: 3 found apbdh

Change Existing Objects 2GG
R



¢ (5 )
Select objects:

Specify first point of mirror line:
<0Ortho on>

Specify second point of mirror line:

Delete source objects? [Yes/No] <N>:

°G)

[ENTER]

ORTHO mode ON cxgcc)@: 935905 (1)
6$EPYO click C\:L)(SOI]II

<click 2>

o]

[ENTER] slsdgé esmodoncd[gleon

° g C N = 0
D ooaliondoodd, mirror copy diseedl
noghsen eonddgnieoadoddlB
mbmaded Delete source objects?

M o C

[Yes/No] <N>: prompt o> Y o3ged
coéeo:q& smcﬁw(f)@@:m D ool

08[gé:03 AutoCAD oogaboddendli

Change Existing Objects
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.o Trim the Objects

» To use the TRIM command

TRIM command u»a8qé object mbscdmencdeded m8cdmdimbs)d delete cwd

giéoymalen mo3fgcloads & (g, o) eolgoonics object e section mdg),dd cut ovd

@éqemén Command line ¢&> TRIM rf’g&j(ﬁooécﬂu

Command: TRIM

6 (g Jo)

Current settings: Projection=UCS, Edge=None

Select cutting edges ...

Select objects: 1 found

Select objects: 1 found, 2 total
Select objects: 1 found, 3 total
Select objects: 1 found, 4 total
Select objects: 1 found, 5 total
Select objects: 1 found, 6 total

Select objects:

Change Existing Objects
I

o 5 cCOC ~
& (- JJ) 9rlgoomep eaxic: (2) 23
grelopt (4) o063 select cvbaledh
pgoeopen Cutting edge aaglon

[ENTER]

OC/‘E'
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- LT

_______

.......................

‘‘‘‘‘‘

% (5 J4J)

Select object to trim or shift-select
to extend or [Project/Edge/Undo]:

Select object to trim or shift-select
to extend or [Project/Edge/Undo]:

Select object to trim or shift-select
to extend or [Project/Edge/Undo]:

trim 09690361&9(13 section (13) ?cﬁ

L

O‘DE)%QJ&: click C\g&ﬂecf)u

sl8af O (G ) 9rlgeomoysadic: trim

qeﬁmeog@:agozo']@u

o (50 Jp)

e

Change Existing Objects
T



- §e§o%@59%m:o>> Gmaogewm(ﬂéemc% DO VRRE  cochem m&@éeoqjé
i 8, L o L L L <] 2,

It ° L
Glopadi
,Q : X & i
%ﬂ\/.—"f 1.- —F 1 r 1
cutting edges objects to trim rssull
selected seiacted
Sample (1)

edges selected with objects to trim selected resutt

Sample (2)

cutting edge selectad abjects to trim selacted result
: with fence selection
Sample (3)
Change Existing Objects Slely



«.¢ Extend the Objects

To use the EXTEND command

>

EXTEND command v»s3q¢ object eoped oadfgo: object sapd, boundary edge ecpc?

&&qq&e@sméqﬁco:qég&ma?:@lcﬂovo.%ll 03663036%@'::0) TRIM 035§é:g$_33q2020'16|1

o (9. Jg) 03091036]5 EXTEND 90389500 653020

Command. EXTEND

Current settings: Projection=UCS, Edge=None

Select boundary edges ...
Select objects:
1 found

Select objects:

Select object to extend or shift-select
to trim or [Project/Edge/Undo]:

First fence point:

Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:

Select object to extend or shift-select
to trim or [Project/Edge/Undo]:

2GE

[ (‘OC" o
boundary edge [gocjemocio; select

C\E&.ﬂn

[ENTER]

FENCE

moo (1) SHPMES

]

mecd (2)

2200 (6) esepBondagit: click cobcl
[ENTER]

[ENTER] sldqt & (e J9) 9rcoma}
o3t extend object cx6Gioyo:dif

Change Existing Objects
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c.oo Fillet the Objects

>

To use the FILLET command

Filleting s8om eibiefgné Bewndh gfiegadd: object (2) 203 200bechoon0) segtioadqo)

arc mm%ieapgmemc G’a@.cxe,so.m@&ﬂmmu o ( J@) w> FILLET command 093

c . ) (S ¢
COCDGOBDQBS E_]coo.t.;]cnw I GC.‘QC\J’)@@O’]H

1

~C
—
=
[
[rp]
~—

Command: FILLET command line szen: Modify menu oes
' Fillet o3 choose cxbqécoph: golonadi

Current settings: Mode = TRIM,

Radius = 0.0000

Select first object or

[Polyline/Radius/Trim]: R fillet radius copdeoiecdad efoslgrordli
Specify fillet radius <0.0000>: 1 fillet radius = 1 3abeopddls

Select first object or -

[Polyline/Radius/Trim]: <click 1>

090 Change Existing Objects
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Select second object: qprefopésdalad (2) o click apbolu sl -
% (5 ) proootEifeomcindts
qéze@o&eogo% sa@:d'g:@:ago:o?@u
TRIM O%crao%:@lom:o?saogng meol
c o

Q2686503 20508 FILLET cobefsp

~

Q. C <

Q@ <
53'30[? QJ):OD(’?ODOD’D@OO’]O'JQJII

gum Fillet sopbatondli promaddmeon Fillet apdfoonidech s3(madcl 1 agubdlencdi
2 3
e
1
ACNY)

> QBBE (2) spoypé:al fillet codeorecdBeg fillet radius v B8gdiepé: (2) glopio
sagorcoigmbomdgédlocd fillet radius Biao§soespociilo current fillet radius

m@?g:m @GB’DE:C\B(} @(%S?O?)S:%]G@O{]C\%éeof)ll (ua ((;. Jd)) O?)GO.?Q)’J@ESJ]II

Change Existing Objects 09) |
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2
¢ (5 o)

Command: FILLET Filleting co6dlecdu

Current settings: Mode = TRIM, current fillet radius o (1.5) sé [gdol
Radius = 1.5000 oo sleoesy §msdad seadielgolon
Select first object or 5 (g. o) ovcborcdfgérn medd (1) g
[Polyline/Radius/Trim]: slopés o select ax&olechi

Select second object: 300 (2) gpelopéa’ select cobcledd

cﬂac_j & 9(9 Ju)) g}mﬂ%@&:g’:@mswc{é

L

oC . . c
=205 Filleting parallel lines co6fay(Gn

.00 Chamfer the Objects

>

To use the CHAMFER command

Chamfering s3o» ¢fefCemcda) gfelgé (2) o Sdepsrodioes mopoeo: (2) 3
woreodendnngt Jesomegsicd TRIM cvbedhi odesodeansiad STRETCH cobfBieon
d L a (o] L L L ° {0} L L e

c o ¢ c._C [ c N N . Q : G Q
F20$3600) qe@@ogmoe Cig someotomoldn line $ polyline leslen) chamfering oy

290 Change Existing Objects
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goloochi chamfering ¢» distance method $ angle method 08 ¢5: (2) $p5:§clonddi
distance method ¢ line sopo? trim uoydd extend axbeed) chamfer length eopad
wchechenqeach angle method mjeom oceydselpéimncgod chamfer length 3

angle o%o%coéeo:%o?goqmosl| eoméf§ 1 Command line &> CHAMFER c38chcopyfe &

(G- Je) Bplmeiqeenty

2.0000

1 |<——— 5.0000———|

XCAN)

- Command: CHAMFER chamfering o3 Modify-»Chamfer o3
choose anqﬂgmé:e@mcﬁn

(TRIM mode) Current chamfer Distl = 2.0000, Dist2 = 3.0000

Select first line or [Polyline/Distance/ Chamfer length eopc? enter codecScl
Angle/Trim/Method]: D slosgrenacl
Select first chamfer distance 5 (5. Jp) oo Bésslod (1) macgod
<2.000>: 5 chamfer length Jli
Select first chamfer distance &:50105 (2) sacga chamfer
<5.000>: 2 length ol '
Change Existing Objects 029G



Command: [ENTER]

CHAMFER

(TRIM mode) Current chamfer Distl = 5.0000, Dist2 = 2.0000
Select first line or [Polyline/Distance/

Angle/Trim/Method]: <click 1>

Select second fine: 3853105 (2) o select cwdSlechs sldet

o (g Jg) 9olgoomoyeacht: Chamfering
(distance method) a3co6eazedl

Command: CHAMFER

(TRIM mode) Current chamfer Length = 1.0000, Angle = 0
Select first line or [Polyline/Distance/

Angle/Trim/Method]: A

Specify chamfer fength on the first line <1.0000>: 5

Specify chamfer angle from the first line <0>: 30

¢———— 5.0000

30°

6 (g 90)

0% Change Existing Objects
e



Command:

CHAMFER

(TRIM mode) Current chamfer Length = 5.0000, Angle = 30
Select first line or [Polyline/Distance/

Angle/Trim/Method]: <click 1>

Select second line: <click 2>
slBgé & (. po) erlgeomahmaits

Chamfering (Angle method) o3 cpofE:

38’33()']@"

»  Command: _chamfer Modify—Chamfer o5 choose cobdli
(TRIM mode) Current chamfer Chamfer length § angle BBoog§ecrdal
Length = 5.0000, Angle = 30 6§0053319205:[030% (. po) o FAE:

olon
2
€ 302

6 (g- 92)

Change Existing Objects 0ns
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Select first line or [Polyline/Distance/
Angle/Trim/Method]: T

Enter Trim mode option
[Trim/No Trim] <Trim>: N

Select first line or [Polyline/Distance/
Angle/Trim/Method]:

Select second line;

Trim mode doéeudad e@@')mnﬂu

i

No Trim mode = o&dleddi

<click 1>

<click 2>

O C = by Qc o
818(3510 (.L) (9« '\)O) ?)BCDO:CT')CTBC?C: (L)G§>C
sg§reaya’ Trim ecpdoy Chamfering

93[:0%026@: Og’): Or]@li

.o Break the Objects

To use the BREAK command

>

C

object CDaC)zL;eJD gap mé%e@Tcgeo:@: object (2) :3@5@33’38 BREAK command gcodeuscs

L [t

olovodi o (9. ?J) @@coozo?d’aa?:eo%ﬁrfg %eoqoge&]é@éqeméu

L

Command: BREAK

Select object:

Specify second break point or [First point]:

Specify first break point:

i

section (1-2) o3 click apdali
F

<click 1>

Change Existing Object
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6 (g-9J)

o

Specify second break point:

Command:
BREAK Select object:

32605 (2) esepeo click apdal

[ENTER]
section (3-4) &3 click cp&cl

Specify second break point or [First point]: F

Specify first break point:

Specify second break point:

<click 3>

<click 4>

Slfeg § (g- 99) 3 [Geagadh

o (5 99)

P
-

L1

Change Existing Objects
- |
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CHAPTER 5

AutoCAD®

CREATE
3D OBJECTS

AutoCAD 3 3D model sopo3 create cobomor 2D object soyones 3D view
spqesmnionbomodd Jeobf sagjsaophiansclonddi slevedd 3D model o3 create codads[d
Deteon Gm&og(ﬁeogsaep:@:o% c;ogae:lo']eugsl (o) 3D model 035;3093 view sadjidrones copdlopd
C\Qgelor]O‘JGSII (J) 3D mes 2D profile 808(7% @%ogog%c%qo']mogn ('\3) 3D model o» hidden line
sopcdeupad rendering cpdeosqt real life object :dacd sacouéiorsynenyaifis eolaadleddi
(g) model o en[z: application soysd export cobfE: animation ooslgbest create wbohssles

ohsooleacdi (7)) 3D model BeeslgsE: engineering analysis o3 + manufacturing data o303
Boradqolondd AutoCAD seess support cpbo 3D model type syon (o) Wireframe

o Create 3D Obijects
R



model (j) Surfaces model 3 (o) Solids model o3clon & model (3) o33 AutoCAD § eea)
C‘féslcﬂoowu Wireframe acgooosa §C 1abielggqc qjm& @ e%]eox: (point line | curve sod Sloéc))

Q [

skeletal model ddeslomalon & model ¢ogcdsnfgcedonssdec drawing o3 calogédqead
d ) 4 L L) L e L

L
N

Surface modeling ¢oyeoy; object edge ecgdlaysalyé surface eogeopds clolooci Surfaces

' & = < O £ c < uOC ~ C c C < "

modeling ¢> drawing object ;dsclesomombac QUIDNRICTITPRM ecﬂm@c%neqooor]oa.u
=8

(28]
]

On

< oy ORI = o N < RiR = CQ NL.o@ <
qmﬁ’)@cm@.momsog%o méea}omm@ Erlepier Uiy m@’),m§19§or}cnmn Surfaces

G} Q

On 4
o

G0

modeling $sdconic) srea00tdmB0090) cdmui?(g HDNGE obaordeilocdi Solids
model eocleep solid Ooooéef)epmée(ﬁ BERERameomedi solid ao o&@éc@e Slonsn sponts
° L L L L L o Ll LA L o]

-

c
C
oc 0 C__0C¢ Q @ (N C oc C

OCiNEOOITI0CIGCRMm C\D:@eﬁ‘ICGCO’J @C [=lop] aC(ﬂO’)().)EI
L L QL 4 2 e G°L

oo Add 3D Thickness to Objects

» To set the 3D thickness of new objects

THICKNESS system variable o8 value 035?% mqConcdecdeniconiqé new object eop
o3 create cwboysesler 5380803 default thickness property saesd AutoCAD aoeoiily
og::epo’]u egoondspdion Properties palette Bseadg8: thickness property a%c;[gp(c::so:
Bqalonudi object céaophie thickness sedjidj:§cgeqdlopn & (7). o) oo object Bt
top view me@@ém:c}mogo% object thicness c3eeoy qdlon

Command: THICKMESS
Enter new value for THICKNESS <0.0000>: 7
Command: LINE

Specify first point: <click 1>

Specify next point or [Undo]: <click 2>

Specify next point or [Undo]: <click 3>

Specify next point or [Close/Undo]: <click 4>

Specify next point or [Close/Undo]: <click 5>

Specify next point or [Close/Undo]: <click 6>
Create 3D Objects obo



Specify next point or [Close/Undo]: <dick 7>
Specify next point or [Close/Undo]: <click 8>
Specify next point or [Close/Undo]: <click 9>
Specify next point or [Close/Undo]: €

8

% (9-0)
PO
il
Command:
Command:  <choose View=>3D Views-)SE Isometric>
Command; _-view
Enter an option [?/Categorize/lAyer statef
Orthographic/Delete/Restore/Save/Ucs/Window]: _seiso
Regenerating model.
_.___*___Eh\
™
/
5 (9 J)
5, =
R
/
olso Create 3D Objects



» To change the 3D thickness of existing objects

oosffeare: drawing object ecpd, 3D thickness Gogo%e@)&eoijgqé w920 [gEeus

l-80 r-80

qulooddi & (9. p) enajoonc) object sogd default thickness o> 0.0 ol object w63

L

5 units G§’)O%CDGCJ%O’OE 7 units @ﬁemge@ézgozqémosa%&%n »dmoos object 093

select cy&[G: right-click cobSh shortcut menu edTaxngt Properties o3 choose coddlecdi

¢ (g- o) oBo3pddl

st
. A
F)
!
1
O
!
]
!
=™
‘/:'\; = 1 - #
N 14 Repeat CIRCLE
_):(> Cut
Capy
Copy with Base Point
Pasgte

Paste as Block
Faste to Otiginal Coordinates

Erase 3

s ¢ (9%)
Copy Selection

Scale

Rotate

Draw Order 4

Deselect Al

Quick Select...
Find. .

4

| 4 Properties palette edlangé General esmnobon Thickness: 0.0000 seox: 5.0000 o
[GEesefe: ENTER 8&clecSt & (9. g) FBlogpzch bspdop circle object saopcd thickness
o?gmé: 7.0000 003 change co:leddi

Create 3D Objects ob |
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E a4, 3 3 L3I W mSSSEEWE“Dﬁ
.......... o
1

< :
X SLdidoud £ |

macs thickness soy [§6[sogmio) object soyal View 3D Orbit ooes vpdlogeset ¢

(9. 9) oolgoomioyseodt: [gEqeadh

>
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» To change the 3D elevation of existing objects
using CHANGE command

spoom(Gsoon: drawing object ;24 3D elevation Gogo%@@')é:eosqjéqé 2903 6\260%6‘;\;
@S & (9. 6) eoadcoma) object eopq, default elevation o 0.0 Sl outer circle object
§, elevation celgréraviganed B0l8i inner circle object & thickness o> 4 units (g5
outer circle object § thickness o> 7 units [g&clexcdi

Command: RECTANG

Specify first corner point or {[Chamfer/
Elevation/Fillet/Thickness/Width]: <click 1>
Specify other corner point or [Dimensions]: <click 2>
Command: THICKNESS

Enter new value for THICKNESS <0.0000>: 4

Command: CIRCLE

Specify center point for circle or

[3P/2P/Ttr (tan tan radius)]: <click 3>
Specify radius of circle or [Diameter]: <click 4>
Command: THICKNESS

Enter new value for THICKNESS <4.0000>: 7

5

Create 3D Objects obg
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Command: CIRCLE .

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: CEN
of <click inner circle>

Specify radius of circle or [Diameter] <1.8460>: <click 5>

b (9. 6) 9>2Geaynicd object eopal NE Isometric view msselgoé:fo3p5: outer cir

L

object o3 select cxbcli s§205G CHANGE command a3seoi(gS: elevation cdelgnt:
BeSoeemti o (9. 9) A

Command: <choose View=>3D Views>SE Isometric>
Command: _-view

Enter an option [?/Categorize/|Ayer state/
Orthographic/Delete/Restore/Save/Ucs/Window]: _seiso
Regenerating model.

${(9-9)
Command: CHANGE
Select objects: <click outer circle>
1 found
ol Create 3D Obje



Select objects: [ENTER]
Specify change point or [Properties]: P

Enter property to change [Color/Elev/

LAyer/LType/ItScale/L Weight/Thickness]: E

Specify new elevation <0.0000>: 4

Enter property to change [Color/Elev/
LAyer/LType/ltScale/LWeight/Thickness]: [ENTER]

% |

» To drop a perpendicular line from a 3D point

down to the XY plane

Command: PLINE

Specify start point:

Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:

Create 3D Objects o6
———

<click 1>

<click 2>
<click 3>
<click 4>



Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 5>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 6>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: €

Command: ELEVATION
Enter new value for ELEVATION <0.0000>: 5
Command: PLINE

Specify start point: ' <click 7>
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <click 8>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 9>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 10>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: €

Command:

Command:  <choose View->3D Views>SE Isometric>
Command: _-view

Enter an option [?/Categorize/lAyer state/
Orthographic/Delete/Restore/Save/Ucs/Window]: _seiso
Regenerating model.

Command: LINE

Specify first point: <QOsnap on> <click 7>
Specify next point or [Undo]: .XY

of @

(need Z): 0

Specify next point or [Undo]: [ENTER]

sldqc line 7-11 oda3(Gsagn:dGn og$0} line 8-12 1 line 9-13 1 line 10-14 cdewpd: 8p5:

L3
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9. Create Surfaces

ceptiod & ce coceaneuys 3D surface sopdedli wireframe %oa’)oooo GS?O(TS okeomé

Q(D’J:E\)GIC @:020% WirEframe C\% GOWO%BE?SIQLDGCDII 8’3380’)‘3 03(')’)1[ surface GO’) O‘)(SCUJ“O’)

&

/

sacpod wireframe Gopmma :0lGn hide codedadomiantordloacy surface qme@epo% G
rrgme;.go(ﬂou mdmedeor, Mesh oméames planar facet sopsesdslg[d: object oésq,
qo%@a@éo% ewT@eo:e.s?moor]u mesh density (facet s’aeelsfaogog) 093 M x N vertices
array mo%?%mo%ffo%cﬂmcf)n mesh GOQO% 2D [go[gd 3D oogblgdoradidedloacdi sleo
00) 9:8mmadiyd apdgudomm 3D 33030%5@56]0’)0& 3D mesh §%L>§o<ééeogcr% 6 (9. 00)
eeal[goonidlondd 1 sopafogpdoli
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To create a rectangular mesh

rectangular mesh més3adqfet Draw-Surfaces>3D Mesh o3 click o»6[G: mesh

Q
Q C

size saopcd M § N value scpadeopdevicl command prompt ol congé vertex point

o L
o [

903003 ooéeozqé 3D mesh mosdd eocm%qcﬂ@u o (3. oo) n%scxgm@éofhl M3 N m$?3:

L L ]

eym 2 ey 256 mogé:@éqcﬂeaﬁn

Command: GRID

Specify grid spacing(X) or [ON/OFF/Snap/Aspect] <0.5000>: [ENTER]
Command:

Command:  <choose Draw-Surfaces>3D Mesh>

Command: _3dmesh

Enter size of mesh in M direction: 3

Enter size of mesh in N direction: 3

Specify location for vertex (0, 0): <Snap on> <click 0,0>
Specify location for vertex (0, 1): <click 0,1>
Specify location for vertex (0, 2): <click 0,2>
Specify location for vertex (1, 0): <click 1,0>
obe Create 3D Objects



Specify location for vertex (1, 1): <click 1,1>

Specify location for vertex (1, 2): <click 1,2>
Specify location for vertex (2, 0): <click 2,0>
Specify location for vertex (2, 1): <click 2,1>
Specify location for vertex (2, 2): <click 2,2>

5 (59

» To create a free-form polygon mesh

< 2 N € Q _C 5 o C & Y C
3D polygon mesh méscdadecdadqe Z axis value dheobeogolechn gispdoreon

oC a Qo C
GO’JGD’DO)S’BOECE(S]L\)H (L) (3- OJ) O’E@EEO'}H

Command:

Command:  <choose View-3D Views>SE Isometric>
Command: _-view

Enter an option [?/Categorize/|Ayer state/
Orthographic/Delete/Restore/Save/Ucs/Window]: _seiso
Regenerating model.

Command:

Create 3D Objects 900
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Command:  <choose Draw->Surfaces—3D Mesh>

Command: _3dmesh

Enter size of mesh in M direction: 4

Enter size of mesh in N direction:
Specify location for vertex (0, 0):
Specify location for vertex (0, 1):
Specify location for vertex (0, 2):
Specify location for vertex (0, 3):
Specify location for vertex (1, 0):
Specify location for vertex (1, 1):
Specify location for vertex (1, 2):
Specify location for vertex (1, 3):
Specify location for vertex (2, 0):
Specify location for vertex (2, 1):
Specify location for vertex (2, 2):
Specify location for vertex (2, 3):
Specify location for vertex (3, 0):
Specify location for vertex (3, 1):
Specify location for vertex (3, 2):
Specify iocation for vertex (3, 3):

4

0,0,0
1,0,2
2,0,2
3,0,0
0,1,0
1,1,2
2,1,2
3,1,0
0,2,0
1,2,2
2,2,2
3,2,0
0,3,0
1,3,2
2,3,2
3,3,0

0?0

% (9-2)
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» To use the 3DFACE tool

Command:

Command:  <choose View->3D Views>SE Isometric>
Command: _-view

Enter an option [?/Categorize/lAyer state/
Orthographic/Delete/Restore/Save/Ucs/Window]: _swiso
Regenerating model.

Command: THICKNESS

Enter new value for THICKNESS <0.0000>: 2.5
Command:

Command:  <click Polygon tool>

Command: _polygon

Enter number of sides <4>: 5

Specify center of polygon or [Edge]: 0,0,0 <point 1>
Enter an option [Inscribed in circle/Circumscribed

about circle] <I>: [ENTER]
Specify radius of circle: 1.55 ' <length 1-2>

Command: CHANGE

Select objects: <click polygon>

1 found

Select objects: [ENTER]
Specify change point or [Properties]: P

Enter property to change [Color/Elev/
LAyer/LType/ItScale/LWeight/Thickness]: E

Specify new elevation <0.0000>: -2.5 <move polygon down -2.5 units>
Enter property to change [Color/Elev/LAyer
[LType/ltScale/LWeight/Thickness]: [ENTER]
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Command: 3DFACE
Specify first point or [Invisible]: 0,0,0 <point 1>
Specify second point or [Invisible]: 0,0,1.25 <point 2>
Specify third point or [Invisible] <exit>: 0,1.5,1.25 <point 3>
Specify fourth point or [Invisible] <create
three-sided face>: 0,1.5,0 <point 4>
Specify third point or [Invisible] <exit>: [ENTER]
3
2
4
+
1
\/ ]
¢ (9- 29)
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Command: MOVE

Select objects: <select face 1234 in fig 5.14>

1 found

Select objects: [ENTER]

Specify base point or displacement: 0,0,0

Specify second point of displacement or

<use first point as displacement>: @-12.5,-0.75,-2 <face 1234 moves
to new position as face 1485>

Command: 3DFACE

Specify first point or [Invisible]: <click 1>
Specify second point or [Invisible]: <click 2>
Specify third point or [Invisible] <exit>: <click 3>
Specify fourth point or [Invisible] <create three-sided face>: <click 4>
Specify third point or [Invisible] <exit>: [ENTER]
Command: [ENTER]
3DFACE Specify first point or [Invisible]: <click 5>
Specify second point or [Invisible]: <click 6>
Specify third point or [Invisible] <exit>: <click 7>
Specify fourth point or [Invisible] <create three-sided face>: <click 8>
Specify third point or [Invisible] <exit>: | [ENTER]

o (9 09)
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To use the Ruled Surface tool

Ruled Surface tool o»a8qé curve (2) 905 ruled surface cds3 soodeuemvn ¥ rod 3
mobilggtordbadqc Surfaces toolbar o> Ruled Surface tool &3 select cobquava: <
eupch command line o> RULESURF command &3 §ebcopbelaog: sacpapclon ¢ (9. ob)
wono; Hodecpajmpdch

Command: THICKNESS

Enter new value for THICKNESS <2.5000>: 0

Command: LINE

Specify first point: <click 1>
Specify next point or {Undo]: : <click 2>

Specify next point or [Undo]: [ENTER]

Command: UCS

Current ucs name: *WORLD*

Enter an option [New/Move/orthoGraphic/
Prev/Restore/Save/Del/Apply/?/World] <World>: E

Select object to align UCS: MID

of _ <click3>

Command: PDMODE
Enter new value for PDMODE <0>: 66
Regenerating model.

Command: POINT

Current point modes: PDMODE=66 PDSIZE=0.0000

Specify a point: MID

of <click 4>

9% Create 3D Objects
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Command: ARC
Specify start point of arc or [Center]: CE
Specify center point of arc: NODE

of <cIick 4>
Specify start point of arc: <click 5>
Specify end point of arc or [Angle/chord Length]: <click 6>

Command: RULESURF

Current wire frame density: SURFTAB1=6

Select first defining curve:  <click on the right section of the curve>
Select second defining curve: <click line 1-2 nearest to point 2>
Command: OOPS '

“"h.,

N
NEavZ
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To use the Sphere tool

Command: UCS

Current ucs name: *NO NAME*

Enter an option [New/Move/orthoGraphic/
Prev/Restore/Save/Del/Apply/?/World] <World>: [ENTER]

Command: SPHERE

Current wire frame density: ISOLINES=4 7
Specify center of sphere <0,0,0>; [ENTER]
Specify radius of sphere or [Diameter]: 1.25

5 (5 09)
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Command: MOVE

Select objects: <select sphere object>
1 found
Select objects: [ENTER]

Specify base point or displacement: 0,0,0
Specify second point of displacement or

<uyse first point as displacement>: -12,0,-3.25
Command: HIDE

Regenerating model.

Use the 3DARRAY Command

a0dskaEfgenmeny qypectoy 6q88:enadGi3ey THICKNESS | ELEVATION 1 2D

Solid command 1 Grips editing § Rotation «v :;@c =op) 0? 3D ARRAY command @Gé@
5205:fg5p5:0 [g6cloncdi

Command: THICKNESS
Enter new value for THICKNESS <0.0000>: 72

Command:

Command:  <choose Draw-Surfaces=2D Solid>
Command: _solid

Specify first point: 6,18

Specify second point: @1<0

Specify third point: @-1,9

Specify fourth point or <exit>: @1<0

Specify third point: [ENTER]

Command:

Create 3D Objects 006
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Command:  <select 2D solid and click sa grip point>
*¥* STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: [ENTER]

% MOVE **
Specify move point or [Base point/Copy/Undo/eXit]: €

** MOVE (multiple) **
Specify move point or [Base point/Copy/Undo/eXit]: @31<0

** MOVE (multiple} **
Specify move point or [Base point/Copy/Undo/eXit]: *Cancel* <press ESC>
Command: *Cancel*

Command: THICKNESS

Enter new value for THICKNESS <72.0000>: 1
Command:

Command:  <choose Draw-Surfaces>2D Solid>
Command: _solid

Specify first point: 7,19

Specify second point: @30<0

Specify third point: @-30,6

Specify fourth point or <exit>: @30,0

Specify third point:  [ENTER]

Command: THICKNESS

Enter new value for THICKNESS <1.0000>: 6
Command:

Command:  <choose Draw-Surfaces>2D Solid>
Command: _solid

Specify first point: 7,25

o9R Create 3D Objects



Specify second point: @30<0
Specify third point: @-30,1
Specify fourth point or <exit>: @30<0

Command: ROTATE3D .
Current positive angle: ANGDIR=counterclockwise ANGBASE=0

Select objects: <click 1>
1 found

Select objects: <click 2>
1 found, 2 total

Select objects: ) [ENTER]

Specify first point on axis or define axis by
[Object/Last/View/Xaxis/Yaxis/Zaxis/2points]: <click 3>
Specify second point on axis: <click 4>
Specify rotation angle or [Reference]: -10

Command: MOVE

Select objects: P

2 found

Select objects: [ENTER]

Specify base point or displacement: 0,0,3
Specify second point of displacement or
<use first point as displacement>: [ENTER]

Command: 3DARRAY

Initializing... 3DARRAY loaded.

Select objects: P

2 found

Select objects: _ ' [ENTER]

Create 3D Objects 000
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Enter the type of array [Rectangular/Polar] <R>: R
Enter the number of rows (---) <1>:
Enter the number of columns (||]) <1>:

Enter the number of levels (...) <1>: 6
Specify the distance between levels (...): 12

T

—

Wi

&
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o.c Create 3D Solids

» To create a solid box

[ENTER]
[ENTER]

& (o o0)

solid box ovbac3 create cpbeddadqé Draw—Solids-»Box o3 choose cobgéeolonddi

sleewrdd command line ¢> BOX command s3§capiqEeophiqglonadn Solids toolbar

ol }28)
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o BOX tool 093 select cxg&q&mé:qo’]mof)u box El em(}%éqmao@&m current UCS

o803 XY plane 3m[iclgbencl command line ¢o s’aao%%cﬁooé@: o (2. o) $305[o3pd i

L L

Solids = x|

%g@&%&

caf[ >#w

% (9 2g)

Command: _-view Enter an option [?/Categorize/lAyer
state/Orthographic/Delete/Restore/Save/Ucs/Window]: _swiso

Regenerating model. <View>3D Views-3>SW Isometric>
Command: ’
Command:

Command: _box

Specify corner of box or [CEnter] <0,0,0>: [ENTER] <This is point 1>
Specify corner or [Cube/Length]: 10,5 <This is point 2>

Specify height: 3 <This is point 3>

> 1Bt & (9. op) eoljeoncimcié: edlesdIf 35503 BOX (Corner methad) ciesl dlonch
8ondsl BOX (Center method) o3sacd(gd: ¢ (9. Jo) rf%aé@éqeswéu
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Command: _box

Specify corner of box or [CEnter] <0,0,0>: CE

Specify center of box <0,0,0>: [ENTER]
Specify corner or [Cube/Length]: L |

Specify length: 4

Specify width: 5

Specify height: 3

6 (9 Jo)

o

e@oo%cm%@é:m surface omésod extrude .§é:$. sgqémé:qo’]m{ﬁu o (3, Jo) 0% FI00

o

L L L L

%@éor]u
Command: RECTANG rectangle o>ézagclechn

Specify first corner point or [Chamfer/
Elevation/Fillet/Thickness/Width]: 0,0 <This is point 1>

Specify other corner point or [Dimensions]: 3,4 <This is point 2>

o0P Create 3D Objects
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Command: EXTRUDE
Current wire frame density: ISOLINES=4

Select objects: <Pick rectangle>
1 found
Select objects: [ENTER]
Specify height of extrusion or [Path]: 5 <Height of the box>
Specify angle of taper for extrusion <0>: [ENTER]
3
™S
. ¢ (9- )
g

» To create a solid cone

solid cone ;dsa? create cobecadqt Draw-»Solids-»Cone o} choose cbgteul
sleewpos command line ¢» CONE command e3§cdeopdeieopSiquloncdi Solids t
4 L 4 LU v,
o> CONE tool o3 select mﬁq&mé:qor]mof)u cone §, Gmn%éeﬂo%&o[gém current
L % ]
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o803 XY plane §xEgderdh egacdombsphion circle o3 extrude sp5:ga3E00ph: solid

cone 3=dalqulonedn command fine o saacdodico

Command: _cone

Current wire frame density: ISOLINES=4
Specify center point for base of cone or
[Elliptical] <0,0,0>:

Specify radius for base of cone or [Diameter]: 5

Specify height of cone or [Apex]: 9

Command: CIRCLE

Specify center point for circle or [3P/2P/
Ttr (tan tan radius)]: 0,0,0

Specify radius of circle or [Diameter]: 7

Dﬂ')j

C

&

B o (9. JJ) o33fegeboh

[ENTER]

<Radius of inner cone>

<Height of inner cone>

<Center of outer cone>
<Radius of outer cone>

Create 3D Objects
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Command: EXTRUDE
Current wire frame density: ISOLINES=4

Select objects: <Select outer circle>

1 found

Select objects: ' [ENTER]

Specify height of extrusion or [Path]: 16 <Height of outer cone>

Specify angle of taper for extrusion <0>: 23

» To create a solid cylinder

solid cylinder ;6905 create cobeddadqé Draw->Salids->Cylinder o3 choose cbedq
SlonoSi s']rj)@u?c% command line ¢> CYLINDER command G%%o%ooéqémé:qﬁ]mcﬁr
Solids toolbar oo CYLINDER tool o3 select codgeopitacloncdi egocdondspdion closed
PLINE oéa03 extrude cxdgtcoph: solid cylinder c3ada8qdlonci command line ¢»

s903§cbeogaf ¢ (3 Jo) ReglogpRdh

Command: CYLINDER
Current wire frame density: ISOLINES=10

Specify center point for base of cylinder
or [Elliptical} <0,0,0>: [ENTER]

Specify radius for base of cylinder or [Diameter]: 5

Specify height of cylinder or [Center of other end]: 7
Command: PLINE

Specify start point: <click 1>
Current line-width is 0.0000 '

Create 3D Objects onls
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Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <chck>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <dick>
<dik>

6 (9 )

o (3. JQ) 0% aocﬁagtﬂecf)u command cooc? mgo%%ogco C@:a;@étﬂll o (:].. Jg) n%@éo’]u

[ I B 2

Command: EXTRUDE

Current wire frame density: ISOLINES=10

Select objects: <Select pline>
1 found
Select objects: [ENTER]

Specify height of extrusion or [Path]: 4

Specify angle of taper for extrusion <0>: [ENTER]
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» To create a solid torus

cC o _C

solid torus o>6a03 create cxbecd=Bé Draw->Solids— Torus o3 choose cxdgEgalondds
L L L L L L

s']cfeo?og command line &> TORUS command @%&wéq&mézq&]mo‘iu Solids toolbar

o TORUS tool o3 select codqeaopdieplencdi eom&f§ 1 command line ¢» seacdgmpfe

oo

('f (3., Jg) o torus ooo%amao@éqssaoéu

L L O

Command: TORUS
Current wire frame density: ISOLINES=10
Specify center of torus <0,0,0>: [ENTER]

Specify radius of torus or [Diameter]: 7

Specify radius of tube or [Diameter]: 1

Command: | [ENTER]

TORUS

Current wire frame density: ISOLINES=10 _

Specify center of torus <0,0,0>: [ENTER]
Create 3D Objects 260



Specify radius of torus or [Diameter]: -2

Specify radius of tube or [Diameter]: 5

soids R I
ATy

To create a solid wedge

C Q

solid wedge ooac} create cobedd=dgé Draw->Solids>Wedge o3 choose cobeés
oloacSi :ﬂ%)eugo% command line ¢> WEDGE command o%%o%wéqémé:s]tﬂmosu
Solids toolbar o» WEDGE tool CJCL)' select C\35s‘[5mé:qorlm(§u GOOOE:@ I command line

Q0 C C a ~ [y Q c
o S’a@cxggmco@@ 6 (9. 6) ?’3@003:0; wedge oae?crg;g@éqemcu

Command; WEDGE

Specify first corner of wedge or [CEnter] <0,0,0>: [ENTER]
Specify corner or [Cube/Length]: L

Specify length: 7

Specify width: 3

Specify height: 4

onE Create 3D Objects
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59 Create a Composite Solid

» To combine two or more solids with UNION

solid box e>dsc} create cpbucisdqé Draw-Solids—Box o3 choose codetadloncdi
sleocdd command line ¢> BOX command o3&cbeopdetaopbiqolonad

Command: GRID
Specify grid spacing(X) or [ON/OFF/Snap/Aspect] <0.5000>: [ENTER]

Command: PLINE

Specify start point: <Snap on> <click 1>
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <click 2>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 3>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <click 4>

Create 3D Objects opo
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Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: A
Specify endpoint of arc or [Angle/CEnter/CLose/Direction/

Halfwidth/Line/Radius/Second pt/Undo/Width]: <click 1>
Specify endpoint of arc or [Angle/CEnter/CLose/Direction/
Halfwidth/Line/Radius/Second pt/Undo/Width]: [ENTER]

Command: EXTRUDE
Current wire frame density: ISOLINES=4

Select objects: <click pline>
1 found
Select objects: [ENTER]

Specify height of extrusion or [Path]: 1

Specify angle of taper for extrusion <0>: [ENTER]

.. 3 4 -
¢ (9 )
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Command:

Command: _-view <click View—>3D Views—=>SW Isometric>
Enter an option [?/Categorize/lAyer state/Orthographic/
Delete/Restore/Save/Ucs/Window]: _swiso Regenerating model.

Command: 2

ZOOM

Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: .6

Command: <Grid off>

Command:

Command:

Command: UCS

Current ucs name: *WORLD*

Enter an option [New/Move/orthoGraphic/Prev/Restore/
Save/Del/Apply/?/World] <World>: M

Specify new origin point or {Zdepth] <0,0,0>: <click 1>

Command:

Command:

Command: UCS

Current ucs name: *NO NAME*

Enter an option [New/Move/orthoGraphic/Prev/Restore/
Save/Del/Apply/?/World] <World>: .X

Specify rotation angle about X axis <90>: [ENTER]

Command: CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: MID
of <click mid of 1-2>

Create 3D Objects ‘ o
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Specify radius of drde or [Diameter]: 2

Command: EXTRUDE

Current wire frame density: ISOLINES=4

Select objects: <click right circle>
1 found
Select objects: [ENTER]

Specify height of extrusion or [Path]: -4

Specify angle of taper for extrusion <0>: [ENTER]

Command: UNION
Select objects: ALL
2 found

Select objects: [ENTER]
Command: HIDE

Regenerating model.

oRP Create 3D Objects
I




Command: DISPSILH
Enter new value for DISPSILH <(>: 1

Command: REGEN
Regenerating model.

Command: HIDE
Regenerating model.

Command: FACETRES
Enter new value for FACETRES <0.5000>: 5

Command: REGEN
Regenerating model.

Command: HIDE
Regenerating model.

6 (9 @)
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